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In This Guide…
The LC/MS Application Guide presents the information you 
need to conduct the LC/MS steps for the Nanospray and 
HPLC-Chip/MS Protein Identification Solutions. In this guide 
you will learn:

• How to fractionate peptides by liquid chromatography

• How to perform MS/MS analyses of peptides

• How to analyze the resulting data with the Spectrum Mill MS 
Proteomics Workbench or the Mascot protein database 
search software

1 Overview of LC/MS Steps with the Protein ID Solutions

Get an overview of the entire process for peptide separation, 
MS/MS analysis, and translation of spectra to protein 
identifications.

2 Setup of Conventional Nanoflow LC/MS/MS System

Learn how to choose the appropriate 1D or 2D LC method, how 
to plumb the system, how to install the nanospray needle, and 
how to prepare the LC and MS just before an analysis.

3 Peptide Separation and Detection with Conventional Nanoflow 
LC/MS/MS

Follow the protocols to perform online 1D and 2D nanoflow 
LC/MS/MS analyses.

4 Setup of HPLC-Chip/MS Ion Trap System

Learn how to plumb the system, how to insert the HPLC-Chip, 
and how to prepare the LC and MS just before an analysis.

5 Peptide Separation and Detection with HPLC-Chip/MS

Follow the protocols to perform online 1D LC/MS/MS analyses 
with an enrichment column or 2D LC/MS/MS analyses.
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6 Optional Peptide Fractionation with Offline SCX

Learn how to fractionate peptides by offline LC with a strong 
cation exchange column and micro-fraction collection.

7 Data Analysis with Spectrum Mill MS Proteomics Workbench

Follow a general Spectrum Mill workbench protocol to process 
MS/MS data to generate tables of protein identifications.

8 Data Analysis with Mascot Protein Database Search

Learn how to use a Visual Basic script to export LC/MSD Trap 
MS/MS data to Mascot format, and how to use Mascot protein 
database search.

9 Reference: Sample Analysis Strategy

Read details about 1D and 2D nanoflow LC/MS/MS sample 
analysis strategy.
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Agilent Nanospray and HPLC-Chip/MS Protein Identification Solutions
LC/MS Application Guide
1
Overview of LC/MS Steps with the 
Protein ID Solutions

Peptide fractionation by LC 2

Mass spectrometry 3

Data analysis 4

Figure 1 gives an overview of the LC fractionation and MS analysis portion of 
the Agilent Nanospray and HPLC-Chip/MS Protein Identification Solutions. 
The applicable chapters from this LC/MS Application Guide are indicated 
adjacent to the workflow. You do the steps in this manual after you complete 
the sample preparation steps covered in the Sample Preparation Guide.

The fundamental difference between the Nanospray Protein Identification 
Solution and the HPLC-Chip/MS Protein Identification Solution is that the 
former uses a conventional nanoflow HPLC system, while the latter uses a 
microfluidic HPLC-Chip.

This guide describes how peptides are fractionated by liquid chromatography 
(LC) in one or more dimensions. An initial separation by strong cation 
exchange (SCX) chromatography may be done offline (Chapter 6), online 
(Chapter 3 and Chapter 5), or not at all. For the final reversed-phase 
separation, the LC or HPLC-Chip is interfaced to a nanospray ion trap mass 
spectrometer (MS) system for MS/MS analysis of the eluted peptides. The 
MS/MS spectra are then searched against protein databases using either 
Mascot or the Spectrum Mill MS Proteomics Workbench.

WARNING Before you begin, be sure you understand all safety considerations and have read all 
applicable material data safety sheets.
1Agilent Technologies



1 Overview of LC/MS Steps with the Protein ID Solutions
Figure 1 Workflow for LC/MS steps of the Nanospray and HPLC-Chip/MS Protein 
Identification Solutions

Peptide fractionation by LC

When MS/MS analyses are performed to identify peptides, the peptides are 
analyzed sequentially, i.e., one peptide at a time. To maximize the number of 
identified proteins, it is important that peptides be well-separated. Liquid 
chromatography (LC) is commonly used to fractionate peptides. Popular 
separation techniques include strong cation exchange (SCX) and 
reversed-phase (RP) LC.

Online 1D LC
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with fraction

collection
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LC/MSD Trap + Mascot
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Nanospray MS/MS

Choose peptide
separation
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Online 1D LC
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Overview of LC/MS Steps with the Protein ID Solutions 1
RPLC can be performed alone or in combination with prior SCX. RPLC can be 
the sole separation technique for simpler mixtures of peptides, for samples 
where it is not as critical to identify as many proteins, or where time 
constraints apply. 

For the Nanospray Protein Identification Solution, RPLC is done with a 
conventional nanoflow LC system. For the HPLC-Chip/MS Protein 
Identification Solution, RPLC is accomplished with a specialized HPLC-Chip, 
the Agilent Protein ID Chip. 

The HPLC-Chip is a microfluidic device that integrates sample preparation 
and analysis on a single chip. The dedicated Protein ID Chip includes a sample 
enrichment column, an analytical column, a nanospray tip, and all 
connections between them. It inserts into the HPLC-Chip/MS interface, which 
includes the nanospray source, connections to the LC pumps and autosampler, 
and the microvalve for column switching.

When both SCX and RP separations are performed, they can be combined in a 
number of ways. Both separations can be done online (online 2D LC). In this 
case, the peptides are eluted from the SCX column by injection of salt plugs, 
are further separated by RPLC, and are then subjected to MS/MS analysis. All 
this is automated on a single LC/MS/MS system. Alternatively, the SCX can be 
done offline with a continuous salt gradient and fraction collection. Then 
those fractions are separated online with RPLC and analyzed by MS/MS. The 
offline approach requires two LC systems, one for SCX and one for RPLC. It 
often yields more protein identifications, but can take significantly more time, 
depending on the number of fractions collected and analyzed. An intermediate 
technique in terms of separating power and time commitment is online 2D 
separation with a semi-continuous salt gradient.

Mass spectrometry

Following LC separation, the peptides are analyzed by mass spectrometry 
(MS). With the Agilent system, the LC eluent enters the ion source of an ion 
trap mass spectrometer via an orthogonal nanospray source. The molecular 
weights of the peptides are determined by MS precursor ion scans. MS/MS 
scans are then triggered on selected precursor ions according to 
data-dependent acquisition rules that are established prior to the analysis. 
The MS spectra provide molecular weights of the peptides, while ion fragments 
in the MS/MS spectra provide amino acid sequence information.
Protein ID Solutions LC/MS App Guide 3



1 Overview of LC/MS Steps with the Protein ID Solutions
Data analysis

The final step in the workflow is data analysis. A major challenge in 
proteomics research is analysis of the vast amounts of data that are generated. 
Often, thousands of MS/MS spectra must be converted to protein 
identifications. With the Nanospray and HPLC-Chip/MS Protein Identification 
Solutions, two different data analysis paths are possible. 

One path uses the Agilent LC/MSD Trap DataAnalysis software to prepare and 
export the MS/MS spectra to Mascot generic format. The exported mass list 
files are then searched using the Mascot protein database search engine. The 
searches are conducted sample-by-sample over the internet, or are automated 
via licensed Mascot Daemon software. The results are then tabulated manually 
or via software developed in the laboratory.

Another path uses the Spectrum Mill MS Proteomics Workbench to extract the 
MS/MS spectra from the raw data files, conduct the protein database searches, 
validate the results via a combination of automated and manual validation, 
and summarize the results in biologist-friendly format. The Spectrum Mill 
workbench allows data from the various LC fractions to be automatically 
consolidated, and permits ready sample comparison.
4 Protein ID Solutions LC/MS App Guide



Agilent Nanospray and HPLC-Chip/MS Protein Identification Solutions
LC/MS Application Guide
2
Setup of Conventional Nanoflow 
LC/MS/MS System 

System components 6

Safety 7

Additional materials required 7

To prepare solvents 7

To plumb the system 8

To prepare and install the nanospray needle 12

To prepare the LC and MS just before an analysis 15

The conventional nanoflow LC/MS system used for the Nanospray Protein 
Identification Solution includes the Agilent nanoflow LC modules and 
nanoflow LC columns coupled with Agilent's orthogonal nanospray source to 
the LC/MSD Trap XCT Plus or XCT Ultra. The LC/MSD Trap software is used 
for complete system control and automation. 

The system includes everything you need to run successful 1D and 2D 
nanoflow LC/MS/MS analyses, including the enrichment column, analytical 
column, connection capillaries, and low-dispersion fittings.

This chapter describes how to set up this system and how to prepare it for an 
analysis. 

If you wish to use the HPLC-Chip/MS Protein Identification Solution, skip to 
Chapter 4. 
5Agilent Technologies



2 Setup of Conventional Nanoflow LC/MS/MS System
System components

Figure 2 Nanoflow LC/MS/MS system

The nanoflow LC/MS/MS system (Figure 2) consists of:

• Agilent 1100 Series nanoflow pump with micro vacuum degasser

• Agilent 1100 Series micro well-plate autosampler with optional thermostat

• Agilent 1100 Series thermostatted column compartment with 2-position/ 
6-port micro valve or the optional Agilent 10-port micro valve and holder 
(required only for online SCX with semi-continuous salt gradient)

• Agilent 1100 Series LC/MSD Trap XCT Plus or XCT Ultra

• Agilent orthogonal nanospray ion source 

• Agilent ChemStation B.01.03 and LC/MSD Trap software 6.0

• Optional second pump: Agilent 1100 Series quaternary, binary, isocratic or 
capillary pump
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Setup of Conventional Nanoflow LC/MS/MS System 2
Safety

For additional safety precautions, see the manuals you received with the 
individual system components.

Additional materials required

In addition to the nanoflow LC/MS/MS system, you need the following 
solvents:

• Water, HPLC grade (18 megohm) - Agilent p/n 8500-2236 or equivalent

• Acetonitrile, HPLC grade - Agilent p/n G2453-85050 or equivalent

• Formic acid, analytical grade - Agilent p/n G2453-85060 or equivalent

To prepare solvents

1 To avoid bacterial growth, use fresh, clean solvent bottles. If you plan to 
analyze a lot of samples, use a 2-L bottle (Agilent p/n 9301-6342) for the 
aqueous solvent.

2 Prepare 0.1% formic acid in water for solvent A1.

3 Prepare 90% acetonitrile + 0.1% formic acid in water for solvent B1.

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.

NOTE The solvent channels used for the nanoflow pump are A1 and B1.

CAUTION Replace the solvent for the B1 channel at least weekly. The A1 solvent is stable longer.

Remember to check your waste bottle frequently. The bottle fills more quickly because 
you split your flow.
Protein ID Solutions LC/MS App Guide 7



2 Setup of Conventional Nanoflow LC/MS/MS System
To plumb the system

1 Decide which LC configuration is most appropriate for your samples. If you 
are unsure, Read “Choosing the LC method” below.

2 Read and follow all instructions in the Agilent Nanoflow LC System for 
Mass Spectrometry (MS) G2229 Quick Start Guide. (Skip this step if you 
did it when the system was installed.)

3 Arrange your LC modules as shown in “Stacking diagrams” on page 10.

4 Read “Plumbing overview” on page 11.

5 Plumb the system.

• For the capillaries to use, refer to the diagram and table in the Agilent 
Nanoflow Proteomics Solution Quick Reference Guide. These provide an 
overview of all the capillaries needed for the installation. 

• Be sure to select only the plumbing components you need for your mode 
of operation (direct injection, enrichment column, 2D LC). For more 
details, refer to diagrams in “Direct injection mode (1D LC)” on page 98.

Choosing the LC method

Before you can plumb the system per instructions in this chapter, you need to 
decide which LC configuration is most appropriate for your samples:

• For very complex samples (e.g., whole cell lysates without prior protein or 
peptide separation), choose 2D LC. Within this category, select one of the 
following:

• If you want the maximum number of proteins identified (and are willing 
to devote the longest analysis time), choose offline SCX. See “Optional 
Peptide Fractionation with Offline SCX” on page 65. Plumb the nanoflow 
LC/MS/MS for 1D LC with enrichment column.

• If you want a moderate number of proteins identified (and are willing to 
devote a moderate analysis time), choose online SCX with 
semi-continuous salt gradient. To plumb and run this method, refer to 
the Agilent application note, “Improved 2D Nano LC/MS for Proteomics 
Applications – a Comparison on Yeast,” Agilent publication number 
5989-0212EN. You must have the optional 10-port valve and additional 
tubing and enrichment column, as described in the publication.

• For a sample of only moderate complexity (such as a gel band with less 
than 20-30 proteins), choose online SCX with salt steps. Plumb the 
nanoflow LC/MS/MS for 2D LC.
8 Protein ID Solutions LC/MS App Guide



Setup of Conventional Nanoflow LC/MS/MS System 2
• For less complex samples, choose 1D LC.

• If samples contain salts or require concentration (i.e., you want to do 
large-volume injections), choose enrichment column mode.

• If samples are clean and sufficiently concentrated so that a 1 µL injection 
is adequate for sensitivity, choose direct injection mode.

For more details on 1D and 2D LC configurations, see Chapter 9, “Reference: 
Sample Analysis Strategy,” starting on page 97. 

NOTE For the direct injection mode, the column compartment and associated six-port valve are 
unused. The analytical column is housed in the nanospray needle holder.
Protein ID Solutions LC/MS App Guide 9



2 Setup of Conventional Nanoflow LC/MS/MS System
Stacking diagrams

version I version II
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Setup of Conventional Nanoflow LC/MS/MS System 2
Plumbing overview

With traditional LC plumbing, you make all the system connections before you 
apply flow. With the nanoflow system, you apply flow after the addition of 
each capillary. This allows you to systematically remove small particles before 
they migrate through the system and cause blockages.

1 Connect capillaries. Start installing capillaries at the pump. Follow this 
procedure:

a Before connecting each capillary tube, set the LC flow to zero. 

b Use a wash bottle of isopropyl alcohol or acetone to lightly rinse the 
outside of the capillary and fitting. This will remove any particles before 
you insert the capillary into the fitting or valve.

c Install the capillary. Tighten the fitting (at the flow sensor if this is the 
first capillary) and set the LC to pump 50/50 A1/B1 at 0.5 µL/min.

d Monitor flow and pressure at the LC control panel. Make sure these 
stabilize before you make the next connection. If they do not stabilize, 
there are likely particles at the front end of the capillary. Backflush the 
capillary to remove them.

e After you observe liquid at the outlet of the capillary, and the flow and 
pressure have stabilized, proceed to the next step.

f Repeat step a through step e until all the capillaries have been installed.

2 Connect columns. Depending on your configuration, you will need to 
connect one to three columns. 

• Connect columns in the same manner as the capillaries. 

• Allow each column to purge to waste before you connect the outlet. 

• Note that you may need to activate the column switching valve to 
establish flow to the various columns.

NOTE If you have not yet calibrated the MS, do not connect the outlet of the analytical column to 
the nanospray needle. First follow the instructions under “To calibrate the MS” on page 17.
Protein ID Solutions LC/MS App Guide 11



2 Setup of Conventional Nanoflow LC/MS/MS System
To prepare and install the nanospray needle

Insertion of C18 particles to prevent needle blockage

1 Assemble the following materials: 

• 30 µm C18 particles, Agilent p/n 79903-85031, included with the 
Nanospray Protein Identification Solution.

• 1 mL methanol or acetonitrile

• Microcentrifuge tube, 1.5 mL capacity

2 Place a very small amount (less than 1 mg) of the C18 particles into the vial. 
There should be only enough to see at the bottom of the vial.

3 Add 1 mL of the organic solvent, close lid, and shake rapidly for about five 
seconds.

4 Dip the blunt end of a nanospray needle (Agilent 9301-6378, or New 
Objective FS360-50-8-D) into the suspension of C18 particles for only one 
second. Do this step quickly because it is easy to get too many of the C18 
particles into the needle, which could result in unwanted chromatography.

5 Recap the vial and store.

Needle installation

1 Insert the blunt end of the needle through the nanospray needle nut and 
conductive ferrule. 

2 Connect the fitting directly to the outlet of the LC column, as shown in 
Figure 3. 

3 Tighten the needle very gently. It should seem as if the needle is not 
tightened enough. 

NOTE It is not necessary to rinse the blunt end prior to installation.

CAUTION Over-tightening may break off glass particles that plug the needle.

If you suspect you have glass particles, use a can of pressurized air to blow out the 
fitting and ferrule. If you fail to do this, the particles may become lodged in subsequent 
replacement needles.
12 Protein ID Solutions LC/MS App Guide



Setup of Conventional Nanoflow LC/MS/MS System 2
Figure 3 Nanospray needle installation

4 Verify that the LC solvent continues to flow out of the needle. A very small 
drop will form within 10 to 20 seconds. Hold the needle assembly under the 
nanospray lamp for best illumination.

Installation of assembly into nanospray source

1 Make sure the capillary voltage is set to 1400 V.

2 Insert the needle/column assembly into the needle holder assembly mount 
on the nanospray source. See Figure 4.

Figure 4 Needle holder in needle holder assembly

Needle positioning and starting of spray

1 With the needle assembly installed, use the microscope to position the 
needle within 3 mm of the flat electrode (modified capillary cap). 

• The microscope field-of-view is 3.5 mm so if the needle tip is just seen at 
one end, the capillary cap will be just seen at the opposite end. 

• For more information on proper alignment of the needle tip, see the 
Orthogonal Nanospray Ion Source User’s Guide.

a

b

CAUTION Do not wipe this drop away. Do not touch the tip of the needle to anything because it is 
very easily damaged.
Protein ID Solutions LC/MS App Guide 13



2 Setup of Conventional Nanoflow LC/MS/MS System
2 Start the spray with caution:

a Verify that the flow rate is 300 nL/min and the solvent composition is 
97:3 A1:B1 (the starting composition for the methods).

b Be sure that a droplet has formed at the needle tip or that a stream has 
started.

c Verify that the dry gas setting is 300 °C.

d Gradually increase the capillary voltage to achieve good spray. View the 
spray through the ocular and, if necessary, slightly rotate the 
needle/column assembly so the spray bends away from the entrance to 
the MS. See Figure 5. This will reduce droplet noise.

e Adjust the capillary voltage until a stable current is reached (typically 80 
to 100 nA). The maximum voltage for the G1982B orthogonal nanospray 
source is 2200 V, and a typical voltage with a new needle is 1600 to 
1700 V.

3 Save the method to store the new Vcap setting.

NOTE Increase the Vcap only to the point where stable spray (without spiking) is achieved, as the 
lifetime of the needle is usually longer at lower Vcap. Look for both a stable and reasonable 
MS spectrum as well as several minutes of stable chromatographic signal (no spiking).

The capillary current should be around 80 to 100 nA at the starting composition of 97:3 
A1/B1, and will drop as the percentage of B1 increases.
14 Protein ID Solutions LC/MS App Guide



Setup of Conventional Nanoflow LC/MS/MS System 2
Figure 5 Bending of spray away from entrance to MS

To prepare the LC and MS just before an analysis

After you have plumbed your nanoflow LC/MS system, you prepare it for 
stable analyses. You purge the LC, calibrate the MS (if not already done), and 
connect the two. Repeat the LC purge any time the system has been shut down 
for more than a day.

To prepare the nanoflow pump

1 Activate the purge mode by selecting Instrument > More Pump1 > Purge. Purge 
the nanoflow pump A1 and B1 solvent channels at 2.5 mL/min for two 
minutes each. If the system has been shut down for more than a few days, 
extend the purge time to five to ten minutes.

2 Switch to 97:3 A1:B1 (the starting composition for the methods) and purge 
for one additional minute.

Tip of needle

Spray bends away
Entrance to MS from MS entrance, 

towards 2nd electrode

NOTE In the purge mode, the flow goes to waste rather than through the analytical system. 
You will not damage your system by using the purge mode at 2.5 mL/min.
Protein ID Solutions LC/MS App Guide 15



2 Setup of Conventional Nanoflow LC/MS/MS System
3 Switch to the starting composition for your analysis. Pump solvent through 
the analytical flow path at 0.3 µL/min.

4 Continue pumping at 0.3 µL/min. and monitor both the flow and pressure. 
For stable nanospray conditions, it is very important that the flow be 
stable. Ripple should be less than 3%. The flow and pressure plots should 
look similar to those in Figure 6 and Figure 7.

5 While you wait for the system to stabilize, prepare the rest of the LC and the 
MS.

Figure 6 Desired stability of flow

Figure 7 Desired stability of pressure
16 Protein ID Solutions LC/MS App Guide



Setup of Conventional Nanoflow LC/MS/MS System 2
To prepare the second pump

If you are using a second pump for the enrichment column mode or 2D LC 
mode, prepare it as follows:

1 Purge the second (capillary- or standard-flow) pump. Open the manual 
purge valve and purge the solvent channel(s) you will use at 2.5 mL/min for 
four minutes each.

2 Switch to your composition and flow rate for sample loading. 

3 Close the manual purge valve.

To prepare the well-plate sampler

If the well-plate sampler has not been used for two days, prime the needle 
wash for 120 seconds. Go to Instrument > More Injector > Prime/Flush Pump. 

To prepare the LC columns

The first time you use a new SCX, enrichment, or nanoflow LC column, 
condition it as follows:

1 Make several injections of a high-level digest sample (e.g., 500 fmol BSA 
digest). 

2 Inject several solvent blanks.

To calibrate the MS

Calibrate the ion trap mass spectrometer as directed in the Orthogonal 
Nanospray Ion Source User’s Guide. 

• Use the ESI tuning mix (G2431A).

• Use the nanospray source.

• Be sure to check the ion trap mass axis calibrations (scan, isolation and 
fragmentation).

• Calibrate the detector gain. In MSD Trap Control, click the Calibration tab, then 
the Detector button.

NOTE A separate needle holder is provided so you can keep the tuning mix infusion assembly 
intact and easily interchange it with the column needle holder assembly.
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2 Setup of Conventional Nanoflow LC/MS/MS System
You should calibrate the MS if:

• This is the first time you are using it.

• You observe mass shifts or other problems indicating the need to calibrate.

• Your background seems unusually low, which indicates aging of the 
detector.

CAUTION The detector ages faster and must be calibrated more frequently when it is new.
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This chapter presents protocols for conventional 1D and 2D nanoflow LC/MS 
analyses. Choice of protocol depends on sample complexity, sample 
cleanliness (presence or absence of salts), peptide concentration, and how 
important it is to identify as many proteins as possible for your study. In 
general, the 2D methods provide more identifications, but at the cost of 
additional analysis time. For guidelines on protocol selection, see “Choosing 
the LC method” on page 8. Before you run any of the protocols, prepare the 
system as described in “To prepare the LC and MS just before an analysis” on 
page 15.

If you plan to use the HPLC-Chip/MS Ion Trap system, skip to Chapter 5. 
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Safety

For additional safety precautions, see the manuals you received with the 
individual system components.

Procedure summary

The following summarizes the various modes of nanoflow LC/MS/MS analysis. 
If you have not yet chosen your operating mode, see “Choosing the LC 
method” on page 8.

1D LC - direct injection mode

A schematic 1D LC method with direct injection is shown in Figure 8, and a 
more detailed flow diagram is given in “Direct injection mode (1D LC)” on 
page 98. For amenable samples, this mode gives the best chromatography, the 
best sequence coverage, and the best sensitivity.

Figure 8 ID LC with direct injection

1 Inject no more than 1 µL sample.

2 Separate peptides on the nanoflow column.

3 Perform MS and MS/MS analysis of separated peptides to obtain molecular 
weight and sequence information. 

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.

Nanoflow LC 
PumpInjector

C18 
Nanocolumn

Online 
MS/MS

Nanoflow LC 
PumpInjector

C18 
Nanocolumn

Online 
MS/MS
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Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS 3
1D LC - enrichment column mode

This 1D LC method uses an enrichment pre-column to remove salts and other 
water-soluble contaminants from samples, and to permit large-volume 
injections (several µL or greater) that would take a long time to load using 
nanoflow rates. A schematic is shown in Figure 9. For more detailed flow 
diagrams, see “Enrichment column mode (1D LC)” on page 99.

Figure 9 1D LC with enrichment column

1 Using a higher flow rate, load sample onto an enrichment column, where 
the peptides are trapped and the samples are desalted. 

2 Switch enrichment column into the solvent path of the nanoflow pump and 
separate sample on the nanoflow column. 

3 Perform MS and MS/MS analysis of separated peptides to obtain molecular 
weight and sequence information. 

2D LC with salt steps

The 2D LC method, shown in Figure 10, uses both SCX and reversed phase 
separations. You load the sample onto an SCX column and then elute it in 
fractions by injecting sequential salt steps. Each injected salt solution elutes a 
fraction of the peptides from the SCX column for analysis by nanoflow 
LC/MS/MS. The result is an individual data file for each step of the salt 
gradient. For more detailed flow diagrams, see “Two-dimensional liquid 
chromatography (2D LC)” on page 101.
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Figure 10 Online 2D LC with salt steps

1 Load sample onto a strong cation exchange column. Non-bound peptides 
flow through to the enrichment column, where the peptides are trapped 
and the samples are desalted. 

2 Switch enrichment column into the solvent path of the nanoflow pump and 
separate sample on the nanoflow column. 

3 Perform MS and MS/MS analysis of separated peptides to obtain molecular 
weight and sequence information. 

4 After the first analysis is complete, switch enrichment column back into the 
path of the cation exchange column.

5 Inject salt solution to elute peptides onto enrichment column. In this step, 
you inject the lowest concentration first and increase salt concentration 
each time you perform the step.

6 Repeat steps 2 to 5 until you finish the highest salt concentration and all 
peptides have been analyzed.
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Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS 3
2D LC with semi-continuous salt gradient

This 2D LC method, shown in Figure 11, is similar to 2D LC with salt steps, but 
provides better peptide separation via a salt gradient and use of two 
enrichment columns for alternate trapping and sample elution. For more 
details, refer to the Agilent application note, “Improved 2D Nano LC/MS for 
Proteomics Applications – a Comparison on Yeast,” Agilent publication 
number 5989-0212EN.

Figure 11 Online 2D LC with semi-continuous salt gradient 

Additional materials required

In addition to the nanoflow LC/MS/MS system, you need the following 
solvents:

• Water, HPLC grade (18 megohm) - Agilent p/n 8500-2236 or equivalent

• Acetonitrile, HPLC grade - Agilent p/n G2453-85050 or equivalent

• Formic acid, analytical grade - Agilent p/n G2453-85060 or equivalent

• Ammonium formate, 5 M - Agilent p/n G1946-85021 (provided with the 
Nanospray Protein Identification Solution)
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Protocol for 1D direct injection LC method

Column ZORBAX 300SB-C18, 75 µm x 150 mm, 3.5 µm particle size or
ZORBAX 300SB-C18, 75 µm x 50 mm, 3.5 µm particle size
(The longer column gives better separations when there are more peaks.) 

Maximum
injection volume

1 µL (maximum volume with this method)

Nanoflow pump A = 0.1% formic acid in water
B = 90% acetonitrile + 0.1% formic acid in water
Flow rate = 300 nL/min

Stop time 40 min

Post time 5 min

Injector program

Table 1 Nanoflow pump solvent gradient

Time (min) % B

0 3

10 3

30 45

33 65

33.01 3

Table 2 Injector program

Step Action

1 Draw default amount from sample, 10 µL/min 
speed, default offset

2 NEEDLE wash in flush port, 5.0 sec

3 INJECT

4 WAIT 10.00 min

5 VALVE bypass
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Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS 3
Needle flush
solvent

20% methanol + 0.1% formic acid in water

Bottom-sensing On, 0.9 mm offset for plastic conical micro-vials (Agilent p/n 9301-0978), or 
0.2 mm for 96-well Eppendorf well plates (Agilent p/n 5042-8502). 

Pre- and post-run
macros

For direct injection mode when the 40-µL injection loop is installed, use 
pre-run and post-run macros to reduce the pressure/flow fluctuation. The 
setup is shown in Figure 12.

The macros are available at www.agilent.com/chem/techsupport. Look under 
Status Bulletins and Patches. Copy the macros to hpchem\core.

Figure 12 Pre-run and post-run macros for direct injection with 40-µL loop
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Protocol for 1D enrichment LC - short method for less complex 
samples

Columns • Enrichment column: ZORBAX 300SB-C18, 0.3 x 5 mm, 5 µm particle size

• Reversed-phase column: ZORBAX 300SB-C18, 75 µm x 150 mm, 3.5 µm or 
ZORBAX 300SB-C18, 75 µm x 50 mm, 3.5 µm particle size 
(The longer column gives better separations when there are more peaks.)

Maximum
injection volume

8 µL or 40 µL, depending on loop installed

Enrichment
column switch

Position 1 at 0 min, position 2 at 5 min, then return to position 1 at 61 min

Nanoflow pump A = 0.1% formic acid in water
B = 90% acetonitrile + 0.1% formic acid in water
Flow rate = 300 nL/min
Primary flow = 200 to 500 µL/min (From the Instrument menu, choose More 
pumps > Auxiliary.)

Stop time 75 min

Post time 5 min

Second pump 3% acetonitrile + 0.1% formic acid in water

Table 3 Nanoflow pump solvent gradient

Time (min) % B

0 3

5 3

8 15

50 45

55 90

60 90

61 3
26 Protein ID Solutions LC/MS App Guide



Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS 3
Isocratic, quaternary or binary pumps use flow gradient given in Table 4 on 
page 27. Capillary pumps use no flow gradient; just set flow to 15 µL/min.

Injector program

Needle flush
solvent

20% methanol + 0.1% formic acid in water

Bottom-sensing On, 0.9 mm offset for plastic conical micro-vials (Agilent p/n 9301-0978), or 
0.2 mm for 96-well Eppendorf well plates (Agilent p/n 5042-8502). 

Table 4 Flow gradient for second (non-capillary) pump

Time (min) Flow (mL/min)

initial 0.005

0.01 0.1

0.50 0.1

1.0 0.05

1.01 0.01

8.0 0.01

8.01 0.005

9.9 0.005

10.0 0

74 0

74.01 0.005

Table 5 Injector program

Step Action

1 Draw default amount from sample, 10 µL/min 
speed, default offset

2 NEEDLE wash in flush port, 5.0 sec

3 INJECT
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Protocol for 1D enrichment LC - long method for more complex 
samples

Columns • Enrichment column: ZORBAX 300SB-C18, 0.3 x 5 mm, 5 µm particle size

• Reversed-phase column: ZORBAX 300SB-C18, 75 µm x 150 mm, 3.5 µm or 
ZORBAX 300SB-C18, 75 µm x 50 mm, 3.5 µm particle size 
(The longer column gives better separations when there are more peaks.)

Maximum
injection volume

8 µL or 40 µL, depending on loop installed

Enrichment
column switch

Position 1 at 0 min, position 2 at 5 min, then return to position 1 at 146 min

Nanoflow pump A = 0.1% formic acid in water
B = 90% acetonitrile + 0.1% formic acid in water
Primary flow = 200 to 500 µL/min (From the Instrument menu, choose More 
pumps > Auxiliary.)

Stop time 160 min

Post time 5 min

Second pump 3% acetonitrile + 0.1% formic acid in water

Table 6 Nanoflow pump solvent and flow gradient

Time (min) % B Flow (µL/min)

0 3 0.3

5 3 0.3

11 15 0.3

131 45 0.3

138 90 0.4

143 90 0.6

146 3 0.4

160 3 0.3
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Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS 3
Isocratic, quaternary or binary pumps use flow gradient given in Table 7 on 
page 29. Capillary pumps use no flow gradient; just set flow to 15 µL/min.

Injector program

Needle flush
solvent

20% methanol + 0.1% formic acid in water

Bottom-sensing On, 0.9 mm offset for plastic conical micro-vials (Agilent p/n 9301-0978) or 0.2 
mm for 96-well Eppendorf well plates (Agilent p/n 5042-8502). 

Table 7 Flow gradient for second (non-capillary) pump

Time (min) Flow (mL/min)

initial 0.005

0.01 0.1

0.50 0.1

1.0 0.05

1.01 0.01

8.0 0.01

8.01 0.005

9.9 0.005

10.0 0

159 0

159.01 0.005

Table 8 Injector program

Step Action

1 Draw default amount from sample, 10 µL/min 
speed, default offset

2 NEEDLE wash in flush port, 5.0 sec

3 INJECT
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Protocol for online 2D LC method with salt steps

LC details

Columns • SCX column: ZORBAX BioSCX Series II, 0.30 x 35 mm, 3.5 µm particle size.

• Enrichment column: ZORBAX 300SB-C18, 0.3 x 5 mm, 5 µm particle size

• Reversed-phase column: ZORBAX 300SB-C18, 75 µm x 150 mm, 3.5 µm or 
ZORBAX 300SB-C18, 75 µm x 50 mm, 3.5 µm particle size 
(The longer column gives better separations when there are more peaks.)

Injection volume 20 µL for salt steps (must have 40 µL loop installed)

Recommended
salt steps

0, 15, 30, 45, 60, 75, 90, 120, 300, 500 mM ammonium formate (prepared in 3% 
acetonitrile + 0.1% formic acid in water). Choose the number of salt steps 
based on sample complexity.

Prepare salt solutions from 5 M ammonium formate stock (Agilent p/n 
G1946-85021). Prepare the solutions directly into the 2-mL glass autosampler 
vials supplied with the Nanospray Protein Identification Solution.

Table 9 Preparation of salt solutions for 2D LC with salt steps

Concentration (mM) Volume of 5 M stock (µL) Volume of water (µL)

15 3 997

30 6 994

45 9 991

60 12 988

75 15 985

90 18 982

120 24 976

300 60 940

500 100 900

1000 100 400
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Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS 3
Enrichment
column switch

Position 1 at 0 min, position 2 at 5 min, then return to position 1 at 61 min if 
you use the short LC method or 146 min if you use the long LC method

Nanoflow pump Use the nanoflow pump settings from either the short or long enrichment 
methods. (See page 26 or page 28.) Choose the appropriate method based on 
the complexity of the sample.

Second pump 3% acetonitrile + 0.1% formic acid in water

Isocratic, quaternary or binary pumps use flow gradient given in Table 10.

Capillary pumps use no flow gradient; just set flow to 15 µL/min.

Table 10 Flow gradient for second (non-capillary) pump

Time (min) Flow (mL/min)

initial 0.005

0.01 0.1

0.50 0.1

1.0 0.05

1.01 0.01

10 0.01

10.01 0.005

15 0.005

15.1 0

74 (short method) or 159 (long method) 0

74.01 (short method) or 159.01 (long method) 0.005
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3 Peptide Separation and Detection with Conventional Nanoflow LC/MS/MS
Injector program

Sequence table A typical sequence table for salt steps is given in Table 12.

Protocol for 2D LC method with semi-continuous salt gradient

For this method, refer to the Agilent application note, “Improved 2D Nano 
LC/MS for Proteomics Applications – a Comparison on Yeast,” Agilent 
publication number 5989-0212EN.

Table 11 Injector program

Step Action

1 Draw default amount from sample, 10 µL/min 
speed, default offset

2 NEEDLE wash in flush port, 5.0 sec

3 INJECT

Table 12 Sequence table to inject salt steps

Line Location Sample 
Name

Method 
Name

Inj/
Location

Sample Type DataFile Inj Volume

1 P1-A-01 Sample 2DLCX.M 1 Sample 0mM 5

2 Vial 1 15mM salt 2DLCX.M 1 Sample 15mM 20

3 Vial 2 30mM salt 2DLCX.M 1 Sample 30mM 20

4 Vial 3 45mM salt 2DLCX.M 1 Sample 45mM 20

5 Vial 4 60mM salt 2DLCX.M 1 Sample 60mM 20

6 Vial 5 75mM salt 2DLCX.M 1 Sample 75mM 20

7 Vial 6 90mM salt 2DLCX.M 1 Sample 90mM 20

8 Vial 7 120mM salt 2DLCX.M 1 Sample 120mM 20

9 Vial 8 300mM salt 2DLCX.M 1 Sample 300mM 20

10 Vial 9 500mM salt 2DLCX.M 1 Sample 500mM 20

11 Vial 10 1000mM salt 2DLCX.M 1 Sample 1000mM 20
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MS/MS method for LC/MSD Trap XCT Plus or XCT Ultra

Source and ion optics conditions

Ionization mode Positive nanospray with Agilent orthogonal source (G1982B)

Drying gas flow 5 L/min 

Dry gas
temperature

300 °C 

Vcap Typically 1600-2000 V (Check for stable current of 80-100 nA at starting 
solvent composition and flow.)

Skim1 30 V

Capillary exit 100 V

Ion trap conditions - MS scan

Trap drive 85

Averages 1

ICC On

Maximum
accumulation

time

150 ms

Smart target 500,000

MS scan range 300-2200

Ion trap conditions - automatic MS/MS

Scan mode Peptide

Number of
precursor ions

3 or 4 for XCT Plus; 5 or 6 for XCT Ultra

Averages 1

Fragmentation
amplitude

1.3 V

SmartFrag On, 30-200%
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Active exclusion On, 2 spectra, 1 min

Prefer +2 On

MS/MS scan
range

100-2000

Ultra scan On

ICC target 500,000

To shut down the nanoflow LC/MS/MS system

To shut down the system, do the following at the end of your sample sequence:

1 Inject two solvent blanks to remove residual peptides from the injector. 
Acquire data for these injections.

• For simple samples, inject the solvent you used to dissolve your peptides.

• For complex samples, inject 50% TFE in 0.1% formic acid in water to 
remove hydrophobic peptides.

2 In the Sequence Parameters, set the post-sequence command/macro to macro 
“SHUTDOWN.MAC”, go. 

3 Before you run your next sequence, open the data files for the blanks and 
check for peptide peaks. If there were substantial peaks in the last 
injection, inject more blanks.

NOTE Note that the Standby command stops the LC pumps, but does not put the ion trap into 
standby mode. The Shutdown macro stops the LC pumps and puts the ion trap into standby 
mode.

CAUTION If you do not plan to use the system for several days, remove the nanospray 
needle/column holder assembly and store in protective plastic sleeve. This will extend 
the life of the needle.
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Troubleshooting

If you have flow path blockages

If you have unstable flow

Cause Solution

1 Fused silica particles in system • Solvent-rinse capillaries and fittings prior to installation.
• Avoid overtightening fittings.
• Avoid excessive bending or coiling of the capillaries. If you coil to a radius of 

less than 40 mm, you will damage the capillaries.
• Avoid kinking, bending or crushing capillaries with LC doors or cover panels.
• Backflush capillaries if they are already blocked.

2 Particles from solvent or sample • Always filter solvents through 0.4 µm filters.
• Clean up samples per Sample Preparation Guide.

3 Nanospray needle blocked due to 
heat without flow

• If you do not plan to use the system for several days, remove the nanospray 
needle/column holder assembly and store in protective plastic sleeve. 

• If the needle is blocked, flush with 100% B1 for 30 min. This sometimes 
removes the blockage.

Cause Solution

1 Flow blockages
(can be especially troublesome in 
direct injection mode with sampler in 
mainpass)

• See “If you have flow path blockages” (above).

2 System pressure too low • Keep system pressure higher than 20 bar at the pump outlet.

3 EMPV needs maintenance • Run the EMPV cleaning procedure. See the nanoflow pump manual.

4 Air bubbles in liquid flow path a Purge pumps if you have not already done so.
b If bubbles persist, pump 500 nL/min of 50% B for 20 min.
c If bubbles still persist, disconnect first capillary at pump end of system and 

purge at higher flow rate. Reconnect first capillary and disconnect next one. 
Purge again. Continue disconnecting capillaries sequentially and purging 
until bubbles are gone.
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If you have unstable spray

If you have poor chromatography

Cause Solution

1 Capillary voltage not set correctly • Adjust the capillary voltage. 
• Using the 8 µm needle tips and liquid flow between 175 and 300 nL/min., 

the capillary voltage should be between 1600 and 2000 volts.
• New needles usually require less voltage, but need slightly more as the 

needle ages and the tip becomes eroded or enlarged.

2 Nanospray needle not positioned 
correctly

• Adjust needle position as described in the Agilent G1982B Orthogonal 
Nanospray Ion Source User’s Guide.

3 Flow path blockages • See “If you have flow path blockages” on page 35 of this chapter.

4 Nanospray needle tip is damaged or 
partly blocked.
(You observe sputtering or split spray)

• Replace the needle, reinstall the needle/column holder assembly in the 
source, and adjust needle position. 

5 Ferrule not making good seal with 
needle

• Replace the ferrule, reinstall the needle/column holder assembly in the 
source, and adjust needle position.

6 Flow too great or needle tip enlarged
(You observe steady bowed stream of 
liquid.)

• Reduce the LC flow.
• Replace the needle as above.

Cause Solution

1 Gaps at LC connections • When you connect a capillary to a fitting or the column, push the capillary into 
the fitting firmly and smoothly to avoid gaps.

• When connections are leaking, set column flow to zero, loosen the fitting, 
reinsert the fused silica and retighten the fitting. If you tighten the fitting 
without re-seating the fused silica tube, you may allow a gap to remain 
between the fused silica and the fitting. This will result in peak dispersion.

2 Note: Chromatography in enrichment 
column mode is generally not as good 
as in direct injection mode.

• Switch to direct injection mode if that is an option. Consider:
• Your injection volume 
• Level of salts and other water-soluble contaminants.
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If you have sample carryover

If you have poor sensitivity

Cause Solution

1 No needle wash • Set up needle wash for well-plate sampler.

2 Inappropriate needle wash solvent • Switch to a solvent combination in which your sample is completely soluble.

3 Residual hydrophobic peptides in the 
injection system

• Inject the following to remove hydrophobic peptides:
• First inject 50% TFE in water.
• Then inject several solvent blanks with a high percentage of organic.

Cause Solution

1 Detector gain adjustment needs to be 
redone

• See instructions for verifying detector setting in your LC/MSD Trap 
documentation.

2 Capillary voltage too high, causing 
corona which can destroy peptides

• Reduce the capillary voltage.

3 Sample degradation from sitting at 
room temperature

• Prepare fresh samples.
• If you have the optional thermostat on the micro well-plate sampler, make 

sure it is turned on and set to 4 °C.

4 Peptides adsorbed on vial surface • Switch to a different vial material (glass or plastic).

5 Bad injection due to air bubble at 
bottom of vial

• Tap vial gently to dislodge air bubble.

6 Unstable spray • See “If you have unstable spray” on page 36 of this chapter.

7 Other nanospray problems • See the troubleshooting chapter in Agilent G1982B Orthogonal Nanospray Ion 
Source User’s Guide.

8 Find Compounds settings not 
optimized for low-level samples, 
giving the appearance of poor 
sensitivity
Note: Because the Find Compounds 
function is so efficient, you can often 
obtain a good Mascot search even 
when peaks are not evident in the 
base peak chromatogram.

• For low-level samples, reduce these thresholds in the data analysis method 
parameters:
• Find-AutoMS(n) compound detection threshold
• Mass List-Apex absolute intensity threshold
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If you have low database search scores or poor sequence coverage

Cause Solution

1 Sample preparation or data 
acquisition problem

• Open the data file and see how many peaks you have in the MS BPC. 
• If you have very few peaks, you have a problem with the sample 

preparation or with the data acquisition settings. See causes 2 through 5 
below, as well as the troubleshooting in the Sample Preparation Guide. 

• If you have a reasonable number of peaks, your problem resides in the data 
processing. See causes 6 through 10 below.

2 Number of precursors for 
data-dependent MSn set too low

• Go to the MS(n) tab on the Trap control screen and set No. of Precursor Ions 
to 3 or 4 for the XCT Plus or 5 to 6 for the XCT Ultra. 

3 Threshold for triggering MSn set too 
high

• Examine your data and set a lower threshold if it appears inadequate MSn 
experiments were generated.

• To set a lower threshold, go to the MS(n) tab on the Trap control screen and 
set Threshold Abs and/or Threshold Rel to a lower number.

4 SmartFrag turned off, resulting in 
inadequate fragmentation

• Click the Fragmentation button on the MS(n) page of the Trap control screen.
• Make sure SmartFrag is checked and set to 30-200%.

5 Poor sensitivity • See “If you have poor sensitivity” on page 37 of this chapter.

6 Default settings for LC/MSD Trap 
data analysis software not 
appropriate for sample (applies only if 
you use Mascot search)

• See “Troubleshooting” on page 95 of Chapter 8, “Data Analysis with Mascot 
Protein Database Search”.

7 Mascot parameters not optimized 
(applies only if you use Mascot 
search)

• See “To use Mascot protein database search” on page 90 of Chapter 8, “Data 
Analysis with Mascot Protein Database Search”.

8 Spectrum Mill Data Extractor 
parameters not set properly (applies 
only if you use Spectrum Mill 
workbench)

• See the documentation you received with the Spectrum Mill MS Proteomics 
Workbench.

9 Spectrum Mill Search parameters not 
set properly (applies only if you use 
Spectrum Mill workbench)

• See the documentation you received with the Spectrum Mill MS Proteomics 
Workbench.

10 Chosen database did not give good 
results.

• Try searching another database.
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Tips

See the tips in the Agilent Nanoflow LC System for Mass Spectrometry (MS) 
G2229 Quick Start Guide and the Agilent Nanoflow Proteomics Solution 
Quick Reference Guide.
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Agilent Nanospray and HPLC-Chip/MS Protein Identification Solutions
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4
Setup of HPLC-Chip/MS Ion Trap 
System 

System components 42

Safety 43

Additional materials required 43

To prepare solvents 43

To plumb the system 44

To configure the Chip Cube 45

To insert the HPLC-Chip and start the spray 46

To prepare the LC and MS just before an analysis 47

The HPLC-Chip/MS Ion Trap system used for the HPLC-Chip/MS Protein 
Identification Solution consists of Agilent nanoflow LC modules, the 
HPLC-Chip/MS interface, the Protein ID Chip, and the LC/MSD Trap XCT 
Ultra. The LC/MSD Trap software is used for complete system control and 
automation. 

The Agilent HPLC-Chip is a polyimide-based chip with microfluidic channels. 
The Protein ID Chip you use for the HPLC-Chip/MS Protein Identification 
Solution is fabricated in a one-dimensional LC configuration. It incorporates 
an enrichment column to remove salts and concentrate the sample, an 
analytical column, a nanoelectrospray tip, and the microfluidic channels that 
connect them. The chip design significantly reduces the number of capillaries 
and fittings you need for nanoflow HPLC/MS. It is reusable and is easier to set 
up and use.

The Protein ID Chip inserts into the Agilent HPLC-Chip/MS interface, which 
couples the LC system and the LC/MSD Trap. The interface includes the valve 
to switch flows between the columns. This chapter describes how to set up 
this system and how to prepare it for an analysis. 
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System components

Figure 13 HPLC-Chip/MS Ion Trap system 

The HPLC-Chip/MS system (Figure 13) consists of:

• Agilent 1100 Series nanoflow pump with micro vacuum degasser

• Agilent 1100 Series micro well-plate autosampler with optional thermostat

• Second pump for sample loading: Agilent 1100 Series capillary pump

• Agilent Protein ID Chip

• Agilent HPLC-Chip/MS interface, which includes:

• HPLC-Chip loading and ejection mechanism

• Microvalve for flow switching

• LC connections to the nanoflow LC pump and to the micro well-plate 
autosampler with loading pump. 

• Orthogonal nanospray ion source with optics for spray visualization

• Agilent ChemStation B.01.03 and LC/MSD Trap software 6.0

• Agilent 1100 Series LC/MSD Trap XCT Ultra

LC/MSD Trap

HPLC-Chip/MS interface

Protein ID Chip
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Safety

For additional safety precautions, see the manuals you received with the 
individual system components.

Additional materials required

In addition to the HPLC-Chip/MS Ion Trap system, you need the following 
solvents:

• Water, HPLC grade (18 megohm) - Agilent p/n 8500-2236 or equivalent

• Acetonitrile, HPLC grade - Agilent p/n G2453-85050 or equivalent

• Formic acid, analytical grade - Agilent p/n G2453-85060 or equivalent

To prepare solvents

1 To avoid bacterial growth, use fresh, clean solvent bottles. If you plan to 
analyze a lot of samples, use a 2-L bottle (Agilent p/n 9301-6342) for the 
aqueous solvent.

2 Prepare 0.1% formic acid in water for solvent A1.

3 Prepare 90% acetonitrile + 0.1% formic acid in water for solvent B1. 

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.

NOTE The solvent channels used for the nanoflow pump are A1 and B1.

CAUTION Replace the solvent for the B1 channel at least weekly. The A1 solvent is stable longer.

Remember to check your waste bottle frequently. The bottle fills more quickly because 
you split your flow.
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To plumb the system

1 Decide which LC configuration is most appropriate for your samples. If you 
are unsure, read “Choosing the LC method” below.

2 Read and follow all instructions in the Agilent Nanoflow LC System for 
Mass Spectrometry (MS) G2229 Quick Start Guide. (Skip this step if you 
did it when the system was installed.)

3 Arrange your LC modules as described in the Agilent 1100 Series G4240A 
HPLC-Chip/MS Cube User's Guide.

4 Read step 1 of “Plumbing overview” on page 11. Also read step 2 of that 
section if you plan to do online 2D LC because you will need to install an 
SCX column. The enrichment and analytical columns are incorporated into 
the Protein ID Chip.

5 Plumb the system. For the capillaries to use, refer to the Agilent 1100 Series 
G4240A HPLC-Chip/MS Cube User's Guide.

Choosing the LC method

Before you can plumb the system per instructions in this chapter, you need to 
decide which LC configuration is most appropriate for your samples:

• For very complex samples (e.g., whole cell lysates without prior protein or 
peptide separation), choose 2D LC. Within this category, select one of the 
following:

• If you want the maximum number of proteins identified (and are willing 
to devote the longest analysis time), choose offline SCX. See “Optional 
Peptide Fractionation with Offline SCX” on page 65. 

• For a sample of only moderate complexity (such as a gel band with less 
than 20-30 proteins), choose online SCX with salt steps. You will need to 
plumb the SCX column. 

• For less complex samples, choose 1D LC. 

For more details on 1D and 2D LC configurations, see Chapter 9, “Reference: 
Sample Analysis Strategy,” starting on page 97.
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To configure the Chip Cube

From the Instrument menu, choose More Chip Cube > Configuration. Refer to 
Figure 14 and configure the Chip Cube as follows:

Injection Flush
Volume

8 µL (for 1D LC) or 16 µL (for 2D LC) with 75-µm needle seat capillary

Loading Pump G1376A

Analytical Pump G2226A

Figure 14 Chip Cube configuration

Explanation

To allow maximum reuse of methods, some configuration parameters are 
specific to the system and are not stored with the method. Examples include 
the injector loop configuration and the plate configuration for the micro-well 
plate sampler.

When you establish the above configuration settings for the Chip Cube, the 
system automatically calculates (based on injection flush volume and sample 
injection volume) when to switch the valve between sample loading and 
sample analysis. Also, when you wish to eject the Protein ID Chip, the system 
calculates how long to wait to release LC pump pressure before it actually 
ejects the HPLC-Chip. So it is critical that you properly configure the Chip 
Cube.
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To insert the HPLC-Chip and start the spray

Inserting the HPLC-Chip

1 Insert the Protein ID Chip (p/n G4240-62001) into the slot on the 
HPLC-Chip/MS interface. 

2 In the ChemStation software, right-click the HPLC-Chip icon and select 
Operate. 

The automatic loading mechanism loads the HPLC-Chip into the 
HPLC-Chip/MS interface and positions the needle tip.

3 Check the video monitor to be sure the Protein ID Chip is in the correct 
position.

Starting the nanoflow pump

1 Set the flow rate to 300 nL/min. 

2 Set the solvent composition to 97:3 A1:B1 (the starting composition for the 
methods).

3 Turn the pump on.

Starting spray

1 Make sure the capillary voltage is set to 1800 V.

2 Confirm that you have a stable current (typically 40 to 50 nA). 

The maximum voltage for the HPLC-Chip/MS orthogonal nanospray source 
is 2200 V, and a typical voltage with a new chip is 1800 V.

3 Save the method to store the new Vcap setting.

NOTE Increase the Vcap to the point where stable spray (without spiking) is achieved. Splitting of 
the stream usually indicates that the voltage is too high. Look for both a stable and 
reasonable MS spectrum as well as several minutes of stable chromatographic signal (no 
spiking).

The capillary current is typically 40 to 50 nA at the starting composition of 97:3 A1/B1, and 
will drop as the percentage of B1 increases.
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To prepare the LC and MS just before an analysis

After you have plumbed your HPLC-Chip/MS system, you prepare it for stable 
analyses. You purge the LC, calibrate the MS (if not already done), and connect 
the two. Repeat the LC purge any time the system has been shut down for 
more than a day.

To prepare the nanoflow pump

Follow directions in “To prepare the nanoflow pump” on page 15.

To prepare the capillary pump

1 Purge the capillary pump. Purge the solvent channel(s) you will use at 2.5 
mL/min for four minutes each.

2 Switch to your composition and flow rate for sample loading. 

To prepare the well-plate sampler

If the well-plate sampler has not been used for two days, prime the needle 
wash for 120 seconds. Go to Instrument > More Injector > Prime/Flush Pump. 

To prepare the Protein ID Chip

The first time you use a new Protein ID Chip, condition it as follows:

1 Make two to three injections of a high-level standard protein digest sample 
(e.g., 100 fmol BSA digest) using the short method on page 51. 

2 Inject a solvent blank.

To calibrate the MS

1 Just before use, prepare a 1:5 dilution of the electrospray calibrant (p/n 
G2421A) in acetonitrile.

2 Install the MS Calibration and Diagnosis Chip (p/n G4240-61001).

3 Connect the dedicated calibrant line from the HPLC-Chip/MS interface to 
the syringe pump.

4 Load the syringe pump with diluted calibrant and start the flow at 18 µL/hr 
(about 300 nL/min). 

5 Calibrate the ion trap mass spectrometer as directed in the Agilent Chip 
Cube Interface Assembly for LC/MSD Trap User’s Guide. 
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• Be sure to check the ion trap mass axis calibrations (scan, isolation and 
fragmentation).

• Calibrate the detector gain. In MSD Trap Control, click the Calibration tab, 
then the Detector button.

You should calibrate the MS if:

• This is the first time you are using it.

• You observe mass shifts or other problems indicating the need to calibrate.

• Your background seems unusually low, which indicates aging of the 
detector.

CAUTION The detector ages faster and must be calibrated more frequently when it is new.

It is a good idea to check the detector gain more frequently if the system is in constant 
use.
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This chapter presents protocols for 1D enrichment mode and 2D nanoflow 
HPLC-Chip/MS analyses. Choice of the 1D or 2D protocol depends on sample 
complexity, peptide concentration, and how important it is to identify as many 
proteins as possible for your study. In general, the 2D methods provide more 
identifications, but at the cost of additional analysis time. For guidelines on 
protocol selection, see “Choosing the LC method” on page 44. Before you run 
any of the protocols, prepare the system as described in “To prepare the LC 
and MS just before an analysis” on page 47.
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Safety

For additional safety precautions, see the manuals you received with the 
individual system components.

Procedure summary

For a summary of the 1D LC procedure for the HPLC-Chip/MS, see “1D LC - 
enrichment column mode” on page 21. For more detailed flow diagrams, see 
“Enrichment column mode (1D LC)” on page 99.

For a summary of the 2D LC procedure for the HPLC-Chip/MS, see “2D LC 
with salt steps” on page 21. For more detailed flow diagrams, see 
“Two-dimensional liquid chromatography (2D LC)” on page 101. 

Additional materials required

In addition to the HPLC-Chip/MS system, you need the following solvents:

• Water, HPLC grade (18 megohm) - Agilent p/n 8500-2236 or equivalent

• Acetonitrile, HPLC grade - Agilent p/n G2453-85050 or equivalent

• Formic acid, analytical grade - Agilent p/n G2453-85060 or equivalent

• Ammonium formate, 5 M - Agilent p/n G1946-85021 (provided with the 
HPLC-Chip/MS Protein Identification Solution)

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.

NOTE While some of the figures in the referenced sections depict a conventional nanoflow 
system, the same principles apply for the HPLC-Chip. Note that the Protein ID Chip contains 
both the enrichment column and the analytical column (C18 nanocolumn). The Protein ID 
Chip does not contain an SCX column.
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Protocol for 1D enrichment LC with Protein ID Chip - short method 
for less complex samples

Configuration See “To configure the Chip Cube” on page 45.

HPLC-Chip Use the Protein ID Chip, p/n G4240-62001. The chip integrates the following 
columns:

• Enrichment column: ZORBAX 300SB-C18, 40 nL, 5 µm particle size

• Reversed-phase column: ZORBAX 300SB-C18, 75 µm x 43 mm, 5 µm particle 
size

Maximum
injection volume

8 µL or 40 µL, depending on loop installed

Chip Cube • Inner valve: Enrichment

• Valve timetable: Enrichment at 7 min

Nanoflow pump A = 0.1% formic acid in water
B = 90% acetonitrile + 0.1% formic acid in water

Flow rate = 300 nL/min

Primary flow = 500 to 800 µL/min (From the Instrument menu, choose More 
pumps > Auxiliary.)

Stop time 9 min 

Post time none

Capillary pump 3% acetonitrile + 0.1% formic acid in water 
Capillary pumps use no flow gradient; just set flow to 4 µL/min.

Needle flush
solvent

20% methanol + 0.1% formic acid in water

Table 13 Nanoflow pump solvent gradient

Time (min) % B

0 3

7 80

7.01 30
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Bottom-sensing On, 0.9 mm offset for plastic conical micro-vials (Agilent p/n 9301-0978), or 
0.2 mm for 96-well Eppendorf well plates (Agilent p/n 5042-8502).

Protocol for 1D enrichment LC with Protein ID Chip - long method 
for more complex samples

Configuration See “To configure the Chip Cube” on page 45.

HPLC-Chip Use the Protein ID Chip, p/n G4240-62001. The chip integrates the following 
columns:

• Enrichment column: ZORBAX 300SB-C18, 40 nL, 5 µm particle size

• Reversed-phase column: ZORBAX 300SB-C18, 75 µm x 43 mm, 5 µm particle 
size

Maximum
injection volume

8 µL or 40 µL, depending on loop installed

Chip Cube • Inner valve: Enrichment

• Valve timetable: Enrichment at 37 min

Nanoflow pump A = 0.1% formic acid in water
B = 90% acetonitrile + 0.1% formic acid in water

Primary flow = 200 to 500 µL/min (From the Instrument menu, choose More 
pumps > Auxiliary.)

Stop time 45 min 

Table 14 Nanoflow pump solvent and flow gradient

Time (min) % B Flow (µL/min)

0 3 0.30

30 45 0.30

35 80 0.30

37 80 0.30

37.01 30 0.45
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Post time none

Capillary pump 3% acetonitrile + 0.1% formic acid in water 
Capillary pumps use no flow gradient; just set flow to 4 µL/min.

Needle flush
solvent

20% methanol + 0.1% formic acid in water

Bottom-sensing On, 0.9 mm offset for plastic conical micro-vials (Agilent p/n 9301-0978), or 
0.2 mm for 96-well Eppendorf well plates (Agilent p/n 5042-8502).
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Protocol for online 2D LC method with Protein ID Chip

LC details

SCX column ZORBAX BioSCX Series II, 0.30 x 35 mm, 3.5 µm particle size.

HPLC-Chip Use Protein ID Chip, p/n G4240-62001. The chip integrates the following 
columns:

• Enrichment column: ZORBAX 300SB-C18, 40 nL, 5 µm particle size

• Reversed-phase column: ZORBAX 300SB-C18, 75 µm x 43 mm, 5 µm particle 
size

Injection volume 20 µL for salt steps (must have 40 µL loop installed)

Recommended
salt steps

0, 15, 30, 45, 60, 75, 90, 120, 300, 500 mM ammonium formate (prepared in 3% 
acetonitrile + 0.1% formic acid in water). Choose the number of salt steps 
based on sample complexity.

Prepare salt solutions from 5 M ammonium formate stock (Agilent p/n 
G1946-85021). Prepare the solutions directly into the 2-mL glass autosampler 
vials supplied with the HPLC-Chip/MS Protein Identification Solution.

Table 15 Preparation of salt solutions for 2D LC with salt steps

Concentration (mM) Volume of 5 M stock (µL) Volume of water (µL)

15 3 997

30 6 994

45 9 991

60 12 988

75 15 985

90 18 982

120 24 976

300 60 940

500 100 900

1000 100 400
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Nanoflow pump Use the nanoflow pump settings from either the short or long enrichment 
methods for the Protein ID Chip. (See page 51 or page 52.) Choose the 
appropriate method based on the complexity of the sample.

Capillary pump 3% acetonitrile + 0.1% formic acid in water

Capillary pumps use no flow gradient; just set flow to 4 µL/min.

Sequence table A typical sequence table for salt steps is given in Table 16.

Table 16 Sequence table to inject salt steps

Line Location Sample 
Name

Method 
Name

Inj/
Location

Sample Type DataFile Inj Volume

1 P1-A-01 Sample 2DLCX.M 1 Sample 0mM 5

2 Vial 1 15mM salt 2DLCX.M 1 Sample 15mM 20

3 Vial 2 30mM salt 2DLCX.M 1 Sample 30mM 20

4 Vial 3 45mM salt 2DLCX.M 1 Sample 45mM 20

5 Vial 4 60mM salt 2DLCX.M 1 Sample 60mM 20

6 Vial 5 75mM salt 2DLCX.M 1 Sample 75mM 20

7 Vial 6 90mM salt 2DLCX.M 1 Sample 90mM 20

8 Vial 7 120mM salt 2DLCX.M 1 Sample 120mM 20

9 Vial 8 300mM salt 2DLCX.M 1 Sample 300mM 20

10 Vial 9 500mM salt 2DLCX.M 1 Sample 500mM 20

11 Vial 10 1000mM salt 2DLCX.M 1 Sample 1000mM 20
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MS/MS method for LC/MSD Trap XCT Ultra

Source and ion optics conditions

Ionization mode Positive nanospray with Agilent orthogonal source included within 
HPLC-Chip/MS interface (G4240A) 

Drying gas flow 4 L/min

Dry gas
temperature

300 °C 

Vcap Typically 1800 V (Check for stable current of about 40-50 nA at starting 
solvent composition and flow.)

Skim1 30 V

Capillary exit 100 V

Ion trap conditions - MS scan

Trap drive 85

Averages 1

ICC On

Maximum
accumulation

time

150 ms

Smart target 500,000

MS scan range 300-2200

Ion trap conditions - automatic MS/MS

Scan mode Peptide

Number of
precursor ions

5 or 6

Averages 1

Fragmentation
amplitude

1.3 V
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SmartFrag On, 30-200%

Active exclusion On, 2 spectra, 1 min

Prefer +2 On

MS/MS scan
range

100-2000

Ultra scan On

ICC target 500,000
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To shut down the HPLC-Chip/MS system

To shut down the system, do the following at the end of your sample sequence:

1 Inject two solvent blanks to remove residual peptides from the injector. 
Acquire data for these injections.

• For simple samples, inject the solvent you used to dissolve your peptides.

• For complex samples, inject 60% acetonitrile + 0.1% formic acid in water 
to remove hydrophobic peptides.

2 In the Sequence Parameters, set the post-sequence command/macro to macro 
“SHUTDOWN.MAC”, go. 

3 Before you run your next sequence, open the data files for the blanks and 
check for peptide peaks. If there were substantial peaks in the last 
injection, inject more blanks.

NOTE Note that the Standby command stops the LC pumps and ejects the Protein ID Chip, but 
does not put the ion trap into standby mode. The Shutdown macro stops the LC pumps and 
puts the Protein ID Chip and the ion trap into standby mode.

CAUTION If you do not plan to use the system for the next eight hours, turn off the LC pumps and 
put the ion trap in standby mode. This extends the life of the electron multiplier. 
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Troubleshooting

If you have flow path blockages

If you have unstable flow

If you have unstable spray

Cause Solution

1 Particles from solvent or sample • Always filter solvents through 0.4 µm filters.
• Clean up samples per Sample Preparation Guide.

Cause Solution

1 Flow blockages • See “If you have flow path blockages” (above).

2 System pressure too low • Keep system pressure higher than 20 bar at the pump outlet.

3 EMPV needs maintenance • Run the EMPV cleaning procedure. See the nanoflow pump manual.

4 Air bubbles in liquid flow path a Purge pumps if you have not already done so.
b If bubbles persist, pump 500 nL/min of 50% B for 20 min.
c If bubbles still persist, disconnect first capillary at pump end of system and 

purge at higher flow rate. Reconnect first capillary and disconnect next one. 
Purge again. Continue disconnecting capillaries sequentially and purging 
until bubbles are gone.

Cause Solution

1 Unstable flow • See “If you have unstable flow” (above).

2 Capillary voltage not set correctly
(You observe sputtering or split 
spray.)

• Adjust the capillary voltage. 
• With a flow of 300 nL/min, the capillary voltage should be 1800 volts. 
• If you observe a split stream, this typically means Vcap is too high.

3 Flow path blockages • See “If you have flow path blockages” (above).
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If you have poor chromatography 

If you have sample carryover

Cause Solution

1 New chip not conditioned • Before you use a new Protein ID Chip for analyses, condition it as described in 
“To prepare the Protein ID Chip” on page 47.

2 Sample overloaded the chip • Inject 1/10 the sample volume or dilute the sample 1:10 and inject again. 
Observe whether the chromatography improves.

Cause Solution

1 No needle wash • Set up needle wash for well-plate sampler.

2 Inappropriate needle wash solvent • Switch to a solvent combination in which your sample is completely soluble.

3 Residual hydrophobic peptides in the 
injection system

• Analyze blanks with high organic until the peaks are gone.
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If you have poor sensitivity

Cause Solution

1 Detector gain adjustment needs to be 
redone

• See instructions for verifying detector setting in your LC/MSD Trap 
documentation.

2 Capillary voltage too high, causing 
corona which can destroy peptides

• Reduce the capillary voltage.

3 Sample degradation from sitting at 
room temperature

• Prepare fresh samples.
• If you have the optional thermostat on the micro well-plate sampler, make 

sure it is turned on and set to 4 °C.

4 Peptides adsorbed on vial surface • Switch to a different vial material (glass or plastic).

5 Bad injection due to air bubble at 
bottom of vial

• Tap vial gently to dislodge air bubble.

6 Unstable spray • See “If you have unstable spray” on page 59 of this chapter.

7 Find Compounds settings not 
optimized for low-level samples, 
giving the appearance of poor 
sensitivity (applies only if you use 
Mascot search)
Note: Because the Find Compounds 
function is so efficient, you can often 
obtain a good Mascot search even 
when peaks are not evident in the 
base peak chromatogram.

• For low-level samples, reduce these thresholds in the data analysis method 
parameters:
• Find-AutoMS(n) compound detection threshold
• Mass List-Apex absolute intensity threshold
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If you have low database search scores or poor sequence coverage

Cause Solution

1 Sample preparation or data 
acquisition problem

• Open the data file and see how many peaks you have in the MS BPC. 
• If you have very few peaks, you have a problem with the sample 

preparation or with the data acquisition settings. See causes 2 through 5 
below, as well as the troubleshooting in the Sample Preparation Guide. 

• If you have a reasonable number of peaks, your problem resides in the data 
processing. See causes 6 through 10 below.

2 Number of precursors for 
data-dependent MSn set too low

• Go to the MS(n) tab on the Trap control screen and set No. of Precursor Ions 
to 5 or 6.

3 Threshold for triggering MSn set too 
high

• Examine your data and set a lower threshold if it appears inadequate MSn 
experiments were generated.

• To set a lower threshold, go to the MS(n) tab on the Trap control screen and 
set Threshold Abs and/or Threshold Rel to a lower number.

4 SmartFrag turned off, resulting in 
inadequate fragmentation

• Click the Fragmentation button on the MS(n) page of the Trap control screen.
• Make sure SmartFrag is checked and set to 30-200%.

5 Poor sensitivity • See “If you have poor sensitivity” on page 61 of this chapter.

6 Default settings for LC/MSD Trap 
data analysis software not 
appropriate for sample (applies only if 
you use Mascot search)

• See “Troubleshooting” on page 95 of Chapter 8, “Data Analysis with Mascot 
Protein Database Search”.

7 Mascot parameters not optimized 
(applies only if you use Mascot 
search)

• See “To use Mascot protein database search” on page 90 of Chapter 8, “Data 
Analysis with Mascot Protein Database Search”.

8 Spectrum Mill Data Extractor 
parameters not set properly (applies 
only if you use Spectrum Mill 
workbench)

• See the documentation you received with the Spectrum Mill MS Proteomics 
Workbench.

9 Spectrum Mill Search parameters not 
set properly (applies only if you use 
Spectrum Mill workbench)

• See the documentation you received with the Spectrum Mill MS Proteomics 
Workbench.

10 Chosen database did not give good 
results.

• Try searching another database.
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Tips

See the tips in the Agilent Nanoflow LC System for Mass Spectrometry (MS) 
G2229 Quick Start Guide. See also the operation and maintenance chapters in 
the Agilent 1100 Series G4240A HPLC-Chip/MS Cube User's Guide. 
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This chapter describes an optional peptide fractionation by offline strong 
cation exchange (SCX) chromatography. This technique can be used to 
fractionate complex samples such as whole cell lysates and biological fluids. 
The collected fractions are later analyzed by LC/MS/MS. When samples are 
less complex or there is a need for greater automation, SCX can be 
accomplished online as the first step in online two-dimensional (2D) 
LC/MS/MS. With the online technique, described in Chapter 3, peptides are 
eluted in fractions from the SCX column by injection of salt solutions of 
increasing ionic strength, and then are analyzed by reversed-phase LC/MS/MS. 
With the offline technique, described in this chapter, peptides are eluted 
continuously from the SCX column by use of a salt gradient, are collected in 
fractions, and then are analyzed by reversed-phase LC/MS/MS. The advantage 
of doing the SCX offline is increased resolution and fewer peptides per 
fraction, which enables identification of more of the low-abundance proteins. 
The disadvantage is that there are more fractions, and this requires more 
LC/MS/MS and data reduction time.
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System components

Figure 15 Offline SCX in combination with nanoflow LC/MS/MS

The fraction collection system consists of:

• Agilent 1100 Series capillary pump with micro vacuum degasser

• Agilent 1100 Series thermostatted micro well-plate autosampler

• Agilent 1100 Series thermostatted column compartment with micro 
2-position/6-port valve

• Agilent 1100 Series diode array detector (DAD) with 500-nL flow cell

• Agilent 1100 Series thermostatted micro collector/spotter

• Agilent ChemStation B.01.03 software
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Optional Peptide Fractionation with Offline SCX 6
Safety

See the manuals that you received with the 1100 Series modules for additional 
safety precautions.

Procedure summary

Schematic overview

Figure 16 shows a schematic diagram of offline 2D LC/MS. You separate 
peptides in the first dimension by offline SCX with fraction collection (the 
topic of this chapter). You then separate the peptides in the second dimension 
with nanoflow LC/MS/MS, as described in Chapter 3 or Chapter 5.

Figure 16 Overall schematic for offline 2D LC/MS 

WARNING Always take proper precautions for handling and disposing of solvents and other 
chemicals. Consult the material data safety sheets supplied by the vendors.
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6 Optional Peptide Fractionation with Offline SCX
Summary of steps

1 Load tryptic peptides onto the SCX column. 

2 Elute peptides with a linear salt gradient. Some general guidelines are given 
in Table 17. More details for two of the gradients are given in Table 18 and 
Table 19.

3 Collect fractions of about 15 µL each with the 1100 Series micro-fraction 
collection system. You can collect smaller fractions, but this will increase 
LC/MS analysis time.

4 Transfer the well-plates containing all collected fractions to the nanoflow 
LC/MS/MS system.

5 Analyze the fractions using one of the following protocols:

• “Protocol for 1D enrichment LC - short method for less complex 
samples” on page 26

Table 17 Salt gradients for peptide mixtures of increasing complexity

Sample complexity Goal SCX gradient (min)
1st part
(0-100 mM 
ammonium formate)

SCX gradient (min)
2nd part
(100-500 mM 
ammonium formate)

Approximate number 
of SCX fractions*

Simple mixture, e.g., 
highly resolved 2D gel 
spot

Maximum number of 
proteins identified

15 3 7

Subcellular fraction Reasonable number of 
proteins identified 
with shorter analysis 
time

30 6 14

Whole cell lysate Reasonable number of 
proteins identified 
with shorter analysis 
time

60 12 28

Whole cell lysate Maximum number of 
proteins identified

120 24 45

* Assuming fractions collected as described on page 71
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Optional Peptide Fractionation with Offline SCX 6
• “Protocol for 1D enrichment LC - long method for more complex 
samples” on page 28 

• “Protocol for 1D enrichment LC with Protein ID Chip - short method for 
less complex samples” on page 51

• “Protocol for 1D enrichment LC with Protein ID Chip - long method for 
more complex samples” on page 52.

More details

For more details, see the application note entitled “Tools and considerations 
to increase resolution of complex proteome samples by two-dimensional 
offline LC/MS,” Agilent publication number 5989-0213EN.

Additional materials required

In addition to the 1100 Series modules, you need the following:

• Water, HPLC grade (18 megohm) - Agilent p/n 8500-2236 or equivalent

• Acetonitrile, HPLC grade - Agilent p/n G2453-85050 or equivalent

• Formic acid, analytical grade - Agilent p/n G2453-85060 or equivalent

• Ammonium formate, reagent grade
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6 Optional Peptide Fractionation with Offline SCX
Protocol for offline SCX

Column Choose one of the following:

• ZORBAX BioSCX Series II, 0.30 x 35 mm, 3.5 µm particle size, p/n 
5065-9912 

• ZORBAX BioSCX Series II, 0.80 mm x 50 mm, 3.5 µm particle size, p/n 
5065-9942 

Capillary pump A = 5% acetonitrile + 0.03% formic acid; B = 5% acetonitrile, 500 mM 
ammonium formate + 0.03% formic acid

Flow 5 µL/min for the 0.3 mm column, or 15 µL/min for the 0.8 mm column

Gradient See Table 18 for a protein mixture of moderate complexity (e.g., a subcellular 
fraction) or Table 19 for a highly complex protein mixture (e.g., a whole cell 
lysate). In both tables, the gradient balances the need to separate proteins 
with the need to optimize analysis time.

Table 18 SCX gradient for fraction collection for moderately complex peptide mixture

Time (min) % B

0 0

30 20

36 100

44 100

44.01 0

Table 19 SCX gradient for fraction collection for highly complex peptide mixture

Time (min) % B

0 0

60 20

72 100

86 100

86.01 0
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Optional Peptide Fractionation with Offline SCX 6
Injection volume Up to 8 µL or 40 µL, depending on loop installed. Typically, you set your 
injection volume to inject no more than 100 to 150 µg total protein per run.

Fraction
collection

Time-based, first fraction 0 - 5 min, remaining fractions each 3 min, liquid 
contact control mode with distance of 0 mm, fraction size 15 µL, cooling 4 °C

Troubleshooting

For additional troubleshooting tips, see the manuals you received with the 
modules in your fraction collection system.

Problem Cause Solution

SCX column plugs 
frequently.

Particles from biological 
samples

Filter or use Agilent Spin Filters (p/n 5185-5990) to remove particulates.

If your column is plugged, you can sometimes recover by backflushing 
the column or replacing the screen at the head of the column. Check 
your column information sheet for the part number for the screen.

All peptides elute in 
the first few fractions.

Salts from biological 
samples

Remove salts with Agilent Cleanup C18 Spin Tubes or Cleanup C18 
Pipette Tips.

Urea or guanidine HCl 
was used in the tryptic 
digestion

Remove salts with Agilent Cleanup C18 Spin Tubes or Cleanup C18 
Pipette Tips.

Excess ammonium 
bicarbonate from 
digestion.

Dry sample. Add 100 to 200 µL water. Repeat drying and water addition 
once or twice, ending with a dry sample. Dissolve sample in 0.1% formic 
acid or other appropriate buffer. 

Some peptides do not 
elute from the SCX 
column.

Highly-charged peptides Run a pH gradient in combination with a salt gradient.
• The SCX method is optimized for tryptic peptides, which typically 

carry no more than 3 or 4 charges.
• For more highly-charged peptides, you may need to run a combination 

salt/pH gradient. For details, see the note on page 104.
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6 Optional Peptide Fractionation with Offline SCX
Tips

Gradient for
fraction

collection

Optimize the gradient for fraction collection for the complexity of your 
samples. For moderately complex samples, use a steeper gradient, as outlined 
in Table 18. For more complex samples, use a shallower gradient, as outlined 
in Table 19. For all gradients described here, you collect a fraction every three 
minutes. 

To identify more proteins, first try extending the gradient, then try collecting 
fractions more frequently. Note that each additional fraction adds to the 
LC/MS analysis time.

Preventing
degradation of

fractions

Be sure the thermostat on the fraction collector is turned on and set to 4 °C. 
Since you do not want to hold samples too long at 4 °C, do not collect more 
fractions than you can analyze in a couple of days.

Plumbing of
capillaries

The capillary you plumb between the diode array detector and the well-plate 
sampler depends on the flow rate you use for fraction collection. For the 5 
µL/min flow rate you use with this application, it is best to use the green 
50-µm ID capillary (p/n G1364-87305).
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Data Analysis with Spectrum Mill MS 
Proteomics Workbench

Procedure summary 74

Protocol for data processing with Spectrum Mill workbench 76

To manually validate results 79

To summarize data 82

Tips 83

This chapter provides a general protocol and tips for processing your data 
with the Spectrum Mill MS Proteomics Workbench. If you do not have the 
Spectrum Mill workbench, proceed to Chapter 8.

The Spectrum Mill workbench is a comprehensive software package that starts 
with raw mass spectral data files and provides tools to rapidly convert these 
to tables of protein identities. This software includes modules for extraction of 
high-quality spectra from raw data files, rapid protein database search of MS 
or MS/MS spectra, data review and validation, and results summary for single 
samples or groups of samples that span complex studies. It also includes 
capabilities for identification of post-translational modifications, for 
quantitative analysis (including but not limited to ICAT quantitation), and for 
de novo sequencing. The software accepts data from multiple vendors’ 
instrument types in multiple file formats. Both public and proprietary 
databases are supported.

The Spectrum Mill workbench provides a means to segregate search results 
that contain a valid interpretation of an MS/MS spectrum from those that do 
not. Results that are validated can be summarized in a results table. Results 
that are not validated can then be subjected to subsequent rounds of searches 
(against other databases or in homology mode, for example). This iterative 
approach allows for efficient processing that can be customized to the needs of 
the study.
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Procedure summary

Figure 17 Summary of iterative processing with the Spectrum Mill workbench 
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For more details, see the Spectrum Mill Application Guide.
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Data Analysis with Spectrum Mill MS Proteomics Workbench 7
Figure 17 shows the iterative MS/MS search strategy with the Spectrum Mill 
workbench. Assuming the goal is to identify as many proteins as possible, the 
following summarizes the process:

1 Copy or move data to the Spectrum Mill server.

2 Preprocess the raw data files with the Data Extractor.

3 Search a database in identity mode, preferably a species subset database for 
the first search.

4 Autovalidate the results with the highest scores. (Validation means that the 
proposed database match is accepted as the correct match for the MS/MS 
spectrum.)

5 Optional: Manually review the medium-quality spectra and validate 
additional results. 

6 Use Tool Belt to create a saved results file of validated protein hits (*.res 
file).

7 Search the spectra that have not been validated:

a Search against validated protein hits for the combination of oxidized 
methionine and pyroglutamic acid. 

b If you suspect phosphorylation, search against validated protein hits for 
the combination of phosphorylated S, phosphorylated T, and 
phosphorylated Y.

c If you suspect other modifications, search for them.

d Search in no enzyme mode against validated protein hits.

e Search in identity mode against a larger database.

8 Continue to perform iterative cycles of database search and validation to 
identify as many proteins as desired.

9 Use Spectrum Summary to examine the remaining unmatched spectra to 
determine if there are high-quality spectra.

10 Perform de novo sequencing on high-quality spectra.
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7 Data Analysis with Spectrum Mill MS Proteomics Workbench
Protocol for data processing with Spectrum Mill workbench

The following describes in detail the iterative search strategy to process 
LC/MS/MS data with the Spectrum Mill workbench. The strategy assumes that 
the goal is to identify as many proteins as possible. If your study does not 
require you to identify so many proteins, you may omit step 5 through step 13. 
For details on use of the Spectrum Mill workbench, see the manuals and online 
help you received with the product. 

1 Copy or move the raw LC/MS/MS data files to the Spectrum Mill server.

• Be sure to set up a directory structure on the server that makes it easy to 
summarize and compare your results. See “Copying data to server” on 
page 83.

2 Extract the data.

• Set the correct cysteine modification.

• For Merge scans with same precursor m/z, if necessary change the time 
range to be compatible with your chromatographic data. A good starting 
point is the default of 15 seconds with a +/- 1.4 m/z window.

3 Do the first database search. 

• Use a database subset (e.g. mammals). 

• Search in identity mode.

• For Spectrum Mill version A.03.02 or later, mark the check box to 
Calculate reversed database scores.

4 Autovalidate in Protein Details mode, then (optionally) in Peptide mode (using 
default settings).

5 Manually validate (down to score of 6, SPI 70 for simple sets).

• Depending on the size of the data set, it may be easiest to do this in 
batches (i.e., first score > 8, then score > 6).

• For guidelines, see “To manually validate results” on page 79.

• If your goal is to maximize the number of identified proteins, do a 
thorough job at this step because your validated results will be the basis 
for further searches.

• If you do not need to maximize the number of identified proteins, skip 
this step because it can be time-consuming and may not produce a large 
number of identifications.

6 Use Tool Belt to create a saved results file of validated protein hits (*.res 
file).
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Data Analysis with Spectrum Mill MS Proteomics Workbench 7
• Be sure to indicate the database you searched since this maps to 
accession numbers.

7 Perform database searches for suspected modifications. Search against 
previously validated protein hits. Search as follows with autovalidation and 
manual validation between each set of conditions:

a Search for pyroglutamic acid and oxidized methionine:

For Spectrum Mill version A.03.02 or later, search in Variable mode for 
pyroglutamic acid and oxidized methionine.

For Spectrum Mill versions prior to A.03.02, search in 
Homology Multi - mq mode.

b If you suspect phosphorylation:

For Spectrum Mill version A.03.02 or later, search in Variable mode for 
the combination of phosphorylated S, phosphorylated T, and 
phosphorylated Y. 

For Spectrum Mill versions prior to A.03.02, search in 
Homology Multi - sty mode. 

c Search for any other modifications you suspect for your sample. (This 
will increase sequence coverage).

8 Search the previously validated results in no enzyme mode to find 
non-specific cleavages for proteins you have already identified. (Set Digest: 
to No enzyme.) Repeat autovalidation and manual validation.

9 When you think you are done, list sequence-not-validated spectra in Protein 
Details mode and look for proteins with multiple peptides. These may 
represent legitimate proteins at low levels. Re-examine the spectra to 
confirm.

10 Optional: Search again using a larger database (entire database or larger 
subset). This is most important when the original subspecies is not 
well-represented in the database. Autovalidate and manually validate.

11 Check statistics in Tool Belt. If there is a significant number of unmatched 
filtered spectra, continue searching.
Protein ID Solutions LC/MS App Guide 77



7 Data Analysis with Spectrum Mill MS Proteomics Workbench
12 Use Spectrum Summary to check for sequence-not-validated spectra with 
sequence tags greater than 6 or 7. Review these and mark as Good Spectrum 
as appropriate.

13 Subject the good spectra to de novo sequencing.

14 When you have gained enough information from your data, summarize the 
results. 

NOTE If the Tool Belt statistics show that only a small percentage of your collected MS/MS 
spectra were filtered, use the LC/MSD Trap DataAnalysis to check your data file to see if 
you collected a large number of MS/MS spectra on background. If so, your MS/MS data 
acquisition threshold may be set too low. To set a higher threshold, go to the MS(n) tab on 
the Trap control screen and set Threshold Abs and/or Threshold Rel to a larger number.
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To manually validate results

See guidelines in Table 20. 

 

Table 20 Guidelines for manual results validation

Guideline Example

The best spectra will generally be 
found by autovalidation, so do not 
expect to see spectra like the one to 
the right.

• Loss of NH3 occurs from R, K, Q 
and N residues.

• Loss of H2O occurs from S, T, E 
and D.

• R, H, K and N are charge-bearing 
residues and increase the 
maximum charge state allowed 
for a peptide fragment.

• Enhanced fragmentation may be 
observed at the following bonds:
• His – Xaa
• Xaa – Gly
• Xaa – Ser

The peptide bond on the N-terminal 
side of Pro is particularly labile 
(high local proton affinity) and 
usually results in an MS/MS 
spectrum dominated by the y-ion 
ending in Pro.
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It is typical to lack fragmentation 
between the first two N-terminal 
amino acids (i.e., no b1 or yx-1 ions).

Look for coverage over a significant 
portion of the backbone.

The peptide bond on the C-terminal 
side of acidic residues (D, E) may 
show enhanced cleavage.

Table 20 Guidelines for manual results validation

Guideline Example

Good

Poor
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Be suspicious of a clumped pattern 
that occurs frequently throughout 
the LC run (usually a background 
ion).

Be suspicious if no ions appear 
above the precursor ion (when 
precursor charge state is >1).

Remember - When in doubt, don’t 
validate. 
• The goal is no false positives.
• Validating a questionable hit 

removes it from subsequent 
searches.

Table 20 Guidelines for manual results validation

Guideline Example

Precursor m/z

Charge state +2
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7 Data Analysis with Spectrum Mill MS Proteomics Workbench
To summarize data

When you summarize data with the Protein/Peptide Summary page, remember 
that you can:

Validate results For Mode, select Peptide, Protein Details, Protein - Single Peptide ID, or Protein - 
Sample Centric Rows Details.

Compare results
across samples

For Data Directory, select more than one sample folder.

Evaluate
fractionation

For Mode, select Protein-Peptide Distribution Columns.

Do light/heavy
calculations

Under Review Fields, mark the L/H check box and select the site of the 
light/heavy modification.

Print results 1 Enable Print background colors and images in Internet Explorer. Select Tools > 
Internet Options.... Click the Advanced tab and mark the check box for Print 
background colors and images.

2 Select File > Page setup... to set the page to landscape mode.

3 Click in the frame you wish to print.

4 Select File > Print Preview....

5 At the top of the Print Preview window, select Only the selected frame.

6 Click the Print... button.

Import data into
Excel, Synapsia

Informatics
Workbench, or

LIMS

1 Mark the Excel Export check box.

2 Click the Summarize button.

3 Check that you see a display with two buttons, one to upload to LIMS and 
another to display the file.

4 Do one of the following:

• To import the data into Excel, import as semicolon-delimited data.

• To import the data into Synapsia, see the Synapsia online help. Be sure 
to copy and paste into the Synapsia Import Data screen only the bold 
portion of the Upload Path from the Spectrum Mill screen. 

• To upload to LIMS, see the Server Administration online help.
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Tips

Copying data to
server

To make it easy to compare data sets, set up the appropriate directory 
structure on the Spectrum Mill server. Whenever you want to compare 
samples in a set, you need to set up a subdirectory for each sample. This 
sample directory may contain data files from multiple sample fractions or gel 
slices. Here are some examples:

• If you perform a two-dimensional LC/MS/MS analysis of a single sample, 
transfer all the files to a single directory on the server.

• If you run the same two-dimensional LC/MS/MS analysis on a second 
sample, or if you repeat the run on the first sample, transfer all these files 
to a second directory.

• If you conduct a differential expression study, transfer samples from one 
cell state into one directory and the second cell state into a second 
directory.

Extracting
spectra

When you extract your data, be sure to remember the following:

• You extract only one directory at a time.

• For Merge scans with same precursor m/z, if necessary change the time range 
to be compatible with your chromatographic data. 

• This option sets the time range for merging scans from the same peak.

• A good starting point is 15 seconds with a +/- 0.5 m/z window.

• If the time range or m/z windows are too wide, you may merge scans for 
more than one peptide.

• If they are too narrow, searches will take longer and you will observe 
redundant hits.

Searching
spectra

Before you search a subset database, review the Spectrum Mill species 
definitions and modify if necessary. For the default species definitions, see the 
online help for the MS/MS Search page.

Validating results For efficient validation of MS/MS search results:

• Use the Autovalidation page to validate the highest-scoring results — those 
that do not require manual review. 

• Use the Protein/Peptide Summary page for manual review and validation of 
medium-scoring results.
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Database Search

Procedure summary 86

To use LC/MSD Trap Visual Basic script to export data to Mascot 87

To use the MASCAT concatenator for multiple sample fractions 89

To use Mascot protein database search 90

To use Mascot Daemon 93

Troubleshooting 95

Tips 96

In this chapter you learn how to perform data analysis using the LC/MSD Trap 
DataAnalysis software and Mascot database search. Mascot from Matrix 
Science Limited is a search engine that uses mass spectra to identify proteins 
from sequence databases. Mascot searches can be performed free of charge at 
www.matrixscience.com. Optional Mascot Daemon software automates the 
searches, but can only be used with an in-house Mascot Server license.

If you have the Spectrum Mill MS Proteomics Workbench, disregard this 
chapter and read Chapter 7 instead.
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Procedure summary

Figure 18 Data analysis with the LC/MSD Trap software and Mascot search

When you use Mascot, data analysis for protein digest samples consists of five 
steps:

1 Use Find Compounds to locate and hierarchically organize related MS and 
MS/MS spectra.

2 Use Mass List Find to label spectra with masses.

3 Perform (optional) charge deconvolution. 

4 Export spectra to Mascot format.

5 Perform Mascot database search.

The first four steps are automated via a Visual Basic script that you add to 
your LC/MSD Trap methods. Once you have generated a Mascot generic format 
(*.mgf) file from your mass spectral data, you conduct an online search on a 
single file at www.matrixscience.com, or an automated search using the 
optional Mascot Daemon software on an in-house server.
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Data Analysis with Mascot Protein Database Search 8
To use LC/MSD Trap Visual Basic script to export data to Mascot 

To activate the Visual Basic script

1 In MSD Trap Control, open the LC/MSD Trap method you created to do the 1D 
or 2D LC/MS/MS analysis of peptides.

2 Select Method > Add DataAnalysis Part. 

3 Select the DataAnalysis method Example DA Methods with Scripts\
Auto_MIS_MgfExport.ms. 

4 Select Method > Save entire Method As to save the LC/MS/MS method with the 
DataAnalysis part attached.

To change processing method parameters

The method Auto_MIS_MgfExport.ms includes:

• The Visual Basic script 

• Starting parameters for Find Compounds AutoMS(n), Mass List Find, 
Deconvolution, and Mascot Export Options

The script does not change or optimize the starting method parameters. If you 
change method parameters (i.e., based on recommendations from 
“Troubleshooting” on page 95), test and save your changes as follows:

1 Select Method > Run to execute the script again on your test data file. 

2 Select Method > Save As to save a new copy of the processing method.

To change the Visual Basic script

The Visual Basic script is shown in Figure 19. To change the script:

1 Select Method > Script.

2 Make the desired change. 

3 Save a new copy of the processing method by selecting Method > Save As.
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Figure 19 Visual Basic script to automate data analysis

For more information on modifying this script or writing new ones, see the 
following help:

• DataAnalysis Online Help (Help > Help Topics > Using processing methods and 
scripting) 

• Visual Basic Script Language Reference (Help > VBScript Language Reference)
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To deactivate the script

If you would prefer not to run this script automatically as part of your 
sequence, do one of the following:

To deactivate in ChemStation:

1 Go to the Method and Run Control view of the ChemStation software. 

2 Select Method > Do MS Post-Run Processing to remove the check mark.

3 Select Method again to verify that the check mark is removed from Do MS 
Post-Run Processing.

To deactivate in LC/MSD Trap software:

1 Go to the MSD Trap Control screen.

2 Select Method.

3 Clear the Run Processing Script check box.

To use the MASCAT concatenator for multiple sample fractions

MASCAT concatenates multiple *.mgf files for Mascot data-base search, 
enabling consolidated search of spectra from two-dimensional LC/MS/MS 
analyses. To use MASCAT: 

1 Click the MASCAT icon.

2 Select data files you wish to combine. See Figure 20 as an example.

3 Enter an output file path and name.

4 Click Concatenate.

5 Click Calculate Number of Queries and decide if the number fits within your 
time and computer memory constraints.

• If so, proceed to do the Mascot search (page 90).

• If not, go to step 6.

6 Regenerate the individual Mascot generic files using a higher threshold for 
compound finding and/or more stringent requirements for input spectral 
quality.

7 Repeat step 1 to step 5.
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Figure 20 MASCAT concatenator to combine *.mgf files from multiple sample fractions

To use Mascot protein database search

1 Decide how you will do the search. The options are:

• Conduct an online search at www.matrixscience.com.

• Conduct an automated search using the optional Mascot Daemon 
software on an in-house server.

2 Set parameters for either type of search. 

• See Figure 21 and the explanations that follow.
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• For more details, see the Mascot online help.

3 Click Start Search... to initiate the Mascot search.

4 View search results either immediately via your web browser, or later via 
email. 

Figure 21 Parameters for Mascot MS/MS Ions Search

Database Search public databases at www.matrixscience.com, or search proprietary 
databases using an in-house server. Search a second database if your first 
choice fails to provide significant data.

Taxonomy For faster searches, select a species or group of species rather than All entries. 
Be aware that some databases do not rigorously classify taxonomy, so if you 
specify taxonomy you may obtain fewer legitimate hits. You may also miss 
homologous proteins from related species. If your search fails to give a result, 
try the Species information unavailable or All entries selections.
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Enzyme Specify the enzyme used for protein digestion. If you are unsure, you can 
select None, but the search will take much longer because all cleavages must be 
considered.

Missed
cleavages

Unless your digestion is perfect, choose 1 or at most 2. You can choose larger 
numbers if you have confidence this is necessary, but larger numbers will 
increase search time and will increase the chance of false positives.

Fixed
modifications

These modifications are applied universally and add no additional search 
time.

Variable
modifications

Avoid specifying a large number without cause. These modifications are not 
applied universally and add significantly to the search time.

Peptide charge Select 1+, 2+, and 3+ unless you know you can more narrowly define the list of 
possible charge states. For example, if you have excluded singly-charged ions 
when setting up your data-dependent acquisition parameters, you can omit 
the 1+ possibility.

Data file Select your *.mgf file from the folder where you saved the exported file.

Instrument Select ESI-Trap.
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To use Mascot Daemon

The optional Mascot Daemon software on an in-house server automates 
database searching. You set search parameters using the Mascot Daemon 
Parameter Editor, shown in Figure 22. Parameter entry is similar to that 
discussed in “To use Mascot protein database search” on page 90.

Figure 22 Mascot Daemon Parameter Editor

You set automation parameters using the Mascot Daemon Task Editor, shown 
in Figure 23. Some of these fields are discussed briefly below. Additional 
information is available via the Mascot Daemon online help.
Protein ID Solutions LC/MS App Guide 93



8 Data Analysis with Mascot Protein Database Search
Figure 23 Mascot Daemon Task Editor

Schedule Schedule searches by time and date, or use the real-time monitor to run 
searches as Mascot generic files are written to a particular directory (e.g., by 
use of a Visual Basic script). 

Follow-up Schedule score-dependent follow-up.

Optional wild
card filename

Search for Mascot generic format files (*.mgf) only.
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Data Analysis with Mascot Protein Database Search 8
Troubleshooting

Problem Cause Solution

Too few proteins 
identified

Default settings for 
LC/MSD Trap data 
analysis software not 
appropriate for sample

Check to see if the threshold for Find Compounds is set too high:
a In the data analysis navigation tree, scroll to the bottom of the 

Compound Mass Spectra node. You should observe a reasonable 
number of compounds for your sample.

b If this is not the case, select Method > Parameters.
c Click the Find tab.
d Click the AutoMS(n) subtab.
e Enter a lower number for the Compound detection, Intensity 

threshold.

Check to see if the retention time window for Find Compounds is set 
appropriately:
a Select Method > Parameters.
b Click the Find tab.
c Click the AutoMS(n) subtab.
d Set Retention time window [min] to base width of the 

chromatographic peaks.

Check to see if the threshold for Mass List Find is set too high:
a Select Method > Parameters.
b Click the Mass List tab. 
c Make sure Apex is selected.
d Click the Apex subtab.
e Enter a smaller number for the Absolute intensity threshold.

Incorrect settings for 
Mascot search

See “To use Mascot protein database search” on page 90.

Chosen database did 
not give good results

Try searching a different database.

Default settings for 
LC/MSD Trap data 
acquisition software not 
appropriate for sample

See the data acquisition troubleshooting tips under “If you have low 
database search scores or poor sequence coverage” on page 38 in 
Chapter 3.
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Tips

Threshold for Find
Compounds

The intensity threshold for Find Compounds determines how many mass spectra 
are exported to Mascot. The appropriate threshold depends upon sample 
concentration and data acquisition parameters. To evaluate where to set the 
threshold, generate a total ion chromatogram containing all the MSn data (TIC, 
All MSn). Set the threshold to a level that includes at least half the MSn data 
points. The lower the threshold, the slower the data processing, but the better 
the chance for improved sequence coverage

Threshold for
Mass List Find

Once you have located correlated MS and MS/MS spectra using Find Compounds, 
check to make sure the mass peaks are labeled. If mass peaks are not labeled, 
they will not be exported to Mascot. Check a few of your lower-intensity 
MS/MS spectra. Zoom in to see if the masses are labeled. You need to zoom in 
to check because the software prevents the labels from overlapping on your 
screen. If you observe good spectra (many fragments at intensities greater 
than the parent ion), but the mass peaks are not labeled (even when you zoom 
in), lower the threshold for Mass List Find.

Problem with sample 
preparation

See the troubleshooting information in the Sample Preparation Guide.

Noisy spectra 
exported to Mascot

In Trap DataAnalysis, set a larger value for Abundance cutoff [%] for 
deconvolution. (The % refers to percent of the most intense peak in the 
mass spectrum.)
a Select Method > Parameters.
b Click the Charge Deconvolution tab. 
c Click the Peptides/Small Molecules subtab.
d Set Abundance cutoff [%] to a higher value.

Problem Cause Solution
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9
Reference: Sample Analysis Strategy

Direct injection mode (1D LC) 98

Enrichment column mode (1D LC) 99

Two-dimensional liquid chromatography (2D LC) 101

This chapter provides an overview of three LC configurations for nanoflow 
LC/MS/MS and describes how they fit various sample analysis strategies. You 
learn when to use each configuration and how to plumb each one.

You can configure nanoflow LC/MS/MS for either one-dimensional liquid 
chromatography (1D LC) or two-dimensional liquid chromatography (2D LC). 
Use 2D LC for very complex protein digests or as a substitute for 2D gel 
electrophoresis. Otherwise, use 1D LC.

You can perform conventional 1D LC either with or without an enrichment 
column. (The Protein ID Chip is preconfigured for the enrichment column 
mode.) The choice of direct injection mode versus enrichment column mode 
depends upon sample characteristics, injection volume, chromatographic 
considerations, and peptide recovery needs.
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Direct injection mode (1D LC)

The following discussion applies only for the Nanospray Protein Identification 
Solution. The direct injection mode is not applicable for the HPLC-Chip/MS 
Protein Identification Solution.

A diagram of the direct injection mode for the conventional nanoflow 
LC/MS/MS system is shown in Figure 24. The direct injection mode provides 
the best chromatography. There is no enrichment column to compromise peak 
resolution.

The direct injection mode also gives better sequence coverage and best 
sensitivity. You may lose peptides if you use the enrichment column. (The 
unrecovered peptides are generally those of lower chain length with less 
diagnostic value, but they may be important for your particular analysis.)

Figure 24 Direct injection mode
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Reference: Sample Analysis Strategy 9
Enrichment column mode (1D LC)

The enrichment 
column is 
sometimes called 
a trapping column 
or a pre-column.

Flow diagrams for the conventional nanoflow LC/MS/MS system in 
enrichment column mode are shown in Figure 25 and Figure 26. Flow 
diagrams for the HPLC-Chip/MS system are similar, but some components are 
contained within the Protein ID Chip. For details on these microfluidic 
components, see the flow diagrams in the Agilent 1100 Series G4240A 
HPLC-Chip/MS Cube User's Guide. 

You use the enrichment column mode to remove salts and other water-soluble 
contaminants from your sample. These are removed before the sample is 
backflushed from the enrichment column onto the analytical column. By 
removing these contaminants, the enrichment column helps to keep the 
system free of materials which can block narrow flow pathways and 
contribute to chemical background.

You also use the enrichment column mode for large-volume injections 
(several µL or greater) that would take a long time to load using nanoflow 
rates. The enrichment column has a larger internal diameter (id) than the 
analytical column and permits sample loading with a standard or capillary 
flow pump rather than a nanoflow pump. 

Figure 25 Enrichment column mode step 1: load sample on enrichment column
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Figure 26 Enrichment column mode step 2: analyze sample
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Two-dimensional liquid chromatography (2D LC)

You can configure nanoflow LC/MS/MS for two-dimensional liquid 
chromatography (2D LC) for instances where separation in a single dimension 
is insufficient. Two-dimensional LC adds a separation based on a different 
physical property. For example, if one of the separations is reversed-phase LC, 
then the second could be ion exchange, size exclusion, affinity, etc. Use 
two-dimensional LC for very complex protein digests or as a substitute for 2D 
gel electrophoresis.

A schematic of 2D LC is shown in Figure 27. In typical 2D LC for protein 
digests, you first separate the peptides on a strong cation exchange (SCX) 
column. You then further separate these fractions by reversed-phase LC. There 
are a number of configurations for the SCX separation:

• Offline SCX with fraction collection (described in Chapter 6)

• Online SCX with salt steps for sample elution (described in detail here)

• Online SCX with a semi-continuous salt gradient for sample elution 
(described in Agilent publication number 5989-0212EN)

Figure 27 Two-dimensional LC concept

There are four steps for online two-dimensional LC with salt plugs. Flow 
diagrams for the conventional nanoflow LC/MS/MS system are shown in 
Figure 28 through Figure 31. Flow diagrams for the HPLC-Chip/MS system are 
similar, but some components are contained within the Protein ID Chip. For 
details on these microfluidic components, see the flow diagrams in the Agilent 
1100 Series G4240A HPLC-Chip/MS Cube User's Guide. 
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9 Reference: Sample Analysis Strategy
In the first step of online 2D LC, you load the digest onto a strong cation 
exchange (SCX) column. (See Figure 28.) You use the Agilent 1100 well-plate 
sampler and a second (standard or capillary) LC pump for sample loading. The 
loading solvent is typically 96.9% water, 0.1% formic acid, and 3% acetonitrile. 
The enrichment column is in-line during sample loading to capture any 
peptides that are not retained on the SCX column.

Figure 28 2D LC step 1: load sample on SCX column

In the second step (Figure 29), you elute the sample from the strong cation 
exchange column onto a C8/C18 enrichment column. You do this by injecting a 
sequential salt gradient with the autosampler. For LC/MS, the volatile salts 
(such as ammonium acetate and ammonium formate) are generally preferred. 
The salt step gradient typically consists of individual salt solutions ranging 
from 15 millimolar to 500 millimolar. These are injected in aliquots related to 
the size of the SCX column. For example, 20-µL aliquots are used for a 0.30 x 
35 mm column. Each injected salt solution elutes a fraction of the peptides 
from the SCX column for analysis by nanoflow LC/MS/MS. The result is an 
individual data file for each step of the salt gradient.

You can optimize the spacing of the salt concentrations for your sample. Some 
samples fractionate more evenly with smaller concentration differences at the 
beginning of the stepwise gradient. For example, you might use 15, 30, 45, 60, 
75, 90, 120, 300, and 500 millimolar concentrations, as opposed to 
concentrations spaced at 50 millimolar increments.
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Figure 29 2D LC step 2: step-elute sample from SCX to enrichment column

In the third step, you wash and desalt the fraction on the enrichment column. 
To do this, you switch the six-port valve in the micro well-plate sampler and 
pump loading solvent or water with the second pump. (See Figure 30.)

Figure 30 2D LC step 3: wash enrichment column
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9 Reference: Sample Analysis Strategy
In the fourth step, you switch the nanoflow pump in-line, and backflush the 
peptide fraction off the enrichment column. You then analyze the fraction 
using nanoflow LC/MS/MS. (See Figure 31.)

Figure 31 2D LC step 4: analyze sample
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NOTE The online and offline SCX protocols provided with the Nanospray and HPLC-Chip/MS 
Protein Identification Solutions are optimized for tryptic peptides. Because trypsin cleaves 
on the carboxy side of lysine and arginine, tryptic fragments most commonly have two 
charges, one for the terminal amino group and one for the basic lysine or arginine residue. 
With other enzymes, the number of charges will be different. Highly-charged peptides may 
not elute from the SCX column with salt steps alone. These may require that the pH be 
raised simultaneously to reduce the number of charges on these peptides. For 
highly-charged peptides, run a combination salt and pH gradient.
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